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Safety

Read this section before installing and operating the 215 Liquid Handler.

The 215 Liquid Handler is intended to be used in a laboratory environment by trained technical 
personnel.

For safe and correct use of this instrument, it is recommended that both operating and service personnel 
follow the instructions contained in this guide when installing, cleaning, and maintaining the 
liquid handler.

The following safety precautions must be observed during all phases of operation, service, and repair of 
the instrument. Failure to comply with these precautions or with specific warnings elsewhere in this 
user’s guide violates safety standards of design, manufacture, and intended use of the liquid handler. 
Gilson assumes no liability for the customer’s failure to comply with these requirements. 

The 215 Liquid Handler has been certified to UL, CSA, and CE Safety standards.
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The following electronic and hazard symbols may appear on the instrument:

Symbol Explanation

~

Alternating current

Courant alternatif

Wechselstrom

Direct current

Courant continu

Gleichstrom

Protective conductor terminal

Borne de terre de protection

Schutzleiteranschluss

|

Electrical power ON

Sous tension

Netzschalter ein

O

Electrical power OFF

Hors tension

Netzschalter aus

Caution

Attention

Vorsicht

Caution, risk of electric shock

Attention, risque de choc électrique

Vorsicht, Elektroschockgefahr

Caution, hot surface

Attention, surface chaude

Vorsicht, heiße Oberfläche

Fuse

Fusible

Sicherung

Keep hands clear of probe

Garder les mains éloignees de l'aiguille

Halten Sie Hände fein von der Nadel
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Safety

The following safety notices may appear in this document:

Voltage

Access to the rear panel is necessary. The liquid handler must be detached from 
all voltage sources before service, repair, or exchange of parts.

For normal operation, the liquid handler is to be grounded through the AC line 
cord provided. Failure to do so can result in a potential shock hazard that could 
result in serious personal injury.

Use only fuses with the rated current and of the specified type as listed on the 
rear panel of the instrument.

The instrument must only be operated with the voltage specified on the rear 
panel label of the instrument using a grounded AC line cord.

Probes

While operating the liquid handler, keep hands clear of probe to avoid risk of 
personal injury by piercing.

Because the probe installed on the Z-arm may contain a dangerous substance, 
do not interfere in the work area of the instrument until the liquid handler has 
completed its procedures. 

WARNING indicates a potentially hazardous 
situation which, if not avoided, may result in 
serious injury

CAUTION indicates a potentially hazardous 
situation which, if not avoided, may result in 
minor or moderate injury

NOTICE indicates a potentially hazardous 
situation which, if not avoided, may result in 
equipment damage
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Solvents

Observe safe laboratory practices when handling solvents. If dangerous liquids 
are used, adequate protection such as proper ventilation, safety glasses, etc., 
should be used.

Refer to the Material Safety Data Sheets for the solvents before use.

Replacement Parts

Be sure to use only original replacement parts, mentioned in Chapter 4, 
Maintenance and Appendix A, Replacement Parts and Accessories. Do not 
repair or change parts which are not listed in this user’s guide. If it is necessary to 
change parts not listed, please contact your Gilson-authorized representative. 
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This chapter provides information on the following topics:

• Description

• Unpacking

• Customer Service

• Technical Specifications
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The 215 Liquid Handler is a large-bed liquid handler used for performing 
dilutions, aliquoting solutions, mixing, plate reformatting, reconstituting 
samples, and more. It accommodates more than 330 racks to hold virtually any 
type of sample vessel, and has a punch strength capable of piercing thick or thin 
septa and microplate mats. The 215 Liquid Handler is intended to be used in a 
laboratory environment by trained technical personnel.
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Unpacking

The 215 Liquid Handler is delivered with most major components already 
assembled. Keep the original container and packing assembly in case the 
liquid handler must be returned.

The 215 Liquid Handler and its components are shipped in two containers:

• One container holds the auxiliary items, such as locator plate, tubing, probes, 
syringes, rinse inserts, Z-arm, and any other accessories you may have ordered 
with your system.

• The other container holds the 215 Liquid Handler.

To remove the liquid handler from its container:

1 Grasp the free end of the strapping around the box. Pull away from the box. 
Be alert when it releases as the strapping is very taut. Repeat for the second 
piece of strapping.

2 Remove the caps on each side of the box.

3 Lift the outer box off and away from the liquid handler.

4 Remove the box labeled “PARTS ENCLOSED” and set aside.

5 Lift the unit off its base platform and place it on a lab bench or cart. 

Gilson recommends that two people lift the liquid handler off 
the base of the packing container. 

Do not attempt to lift the instrument from the Y-arm (the 
horizontal arm). Always lift the instrument from its base.

a) Using the two cutouts for hand holds, place a hand at the base of the 
packing container. 

b) Grip the liquid handler under the base plate.

c) Lift the unit up and out of the foam packing material. The side containing 
the electronics cabinet is the heavier side.
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After the instrument and accessories containers have been unpacked, you 
should have the following:

• 215 Liquid Handler (part number 2510121) or 
215 Liquid Handler without Pump (part number 2510191)

• 215 Utility Programs CD

• power cords

• cable support rod

• tubing support rod

• liquid level detection cable

• GSIOC cable

• terminal block connectors

• fuses

• locator plate

• fuse drawers

Documentation

The following documents are included with the 215 Liquid Handler.

• 215 Liquid Handler Documentation CD

• Declaration of Conformity

• Installation Qualification/Operational Qualification Procedures

Accessories

Based upon your configuration, you also received additional accessories, most 
ordered separately.
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Syringe Pump

If you ordered the 215 Liquid Handler with a syringe pump, the syringe pump is 
installed and the syringe valve, vent tubing, and inlet tubing are supplied.

Syringe

Order the syringe separately.

Z-Arm

The liquid handler is supplied with a 125 mm Z-arm and Z-height adjustment 
tool.

Optionally, substitute a 175 mm Z-arm.

Part Number Description

25025341 100 μL syringe

25025342 250 μL syringe

25025347 500 μL syringe

25025343 1 mL syringe

25025344 5 mL syringe

25025345 10 mL syringe

25025346 25 mL syringe

Part Number Description

250615/2 SUBSTITUTE 175 MM VERTICAL ARM ON 215
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The Gilson 215 Liquid Handlers are supplied with a rinse station and a waste 
bottle. A rinse station insert is required, but not included, as there are six options 
to choose from:

Part Number Description

25245532 Shallow-pocket rinse station insert, closed-bottom, for 
applications where the probe is only immersed in a few 
millimeters of the sample; for use with 125 mm Z-arm.

25245533 Deep-pocket rinse station insert, closed-bottom, allows for 
deeper insertion of the probe into the rinse well, resulting in 
a greater area of the outside of the probe to be rinsed; for use 
with 125 mm Z-arm.

25245531 Flow-through rinse station insert, open-bottom, for flowing 
rinse applications; for use with 125 mm Z-arm.

25245542 Shallow-pocket rinse station insert, closed-bottom, for 
applications where the probe is only immersed in a few 
millimeters of the sample; for use with 175 mm Z-arm.

25245543 Deep-pocket rinse station insert, closed-bottom, allows for 
deeper insertion of the probe into the rinse well, resulting in 
a greater area of the outside of the probe to be rinsed; for use 
with 175 mm Z-arm.

25245541 Flow-through rinse station insert, open-bottom, for flowing 
rinse applications; for use with 175 mm Z-arm.
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Locator Plate

The liquid handler is supplied with a 5-position locator plate. 

Optionally, if using only Code 20- or 30-series racks, order the 7-position locator 
tray:

Or, if using an 818 AutoMix, order the 6-position locator plate:

Control Software

The 215 Liquid Handler is fully supported in both TRILUTION® LC Software and 
TRILUTION® LH Software.

RS-232 Cable

The 215 Liquid Handler is supplied with a GSIOC cable for connecting the 
liquid handler to other instruments.

Optionally, order an RS-232 cable to connect the liquid handler to the computer.

Part Number Description

2504627 Locator tray for installing up to seven Code 20- or 30-series 
racks on the locator plate.

Part Number Description

25045513 LOCATOR PLATE, 6 POSITION, 215

Part Number Description

210631Rxx TRILUTION® LC Software

210630Rxx TRILUTION® LH Software

Part Number Description

36083122 Serial cable, IBM AT-type, 9-pin female to 25-pin male
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Order transfer tubing separately.

Probe

A probe is required, but not included, as there are many options to choose from. 
Refer to Appendix A, Replacement Parts and Accessories for part numbers.

Probe Holder/Guide Kit

A probe holder/guide kit is required, but not included, as there are several 
options to choose from:

Racks

Based on your requirements, you’ll need racks. Refer to Appendix B, Racks for 
part numbers.

Part Number Description

499421202 1.5 mL FEP tubing; 0.8 mm ID x 10 feet

499424012 1 mL coiled FEP tubing, 0.8 mm ID.

499474032 3 mL coiled FEP Tubing, 0.8 mm ID, for 215

499474052 5 mL coiled FEP transfer tubing; 1.5 mm ID

499474102 10 mL coiled FEP tubing; 1.5 mm ID x 24 feet

499474252 25 mL coiled FEP tubing; 1.5 mm ID x 50 feet

Part Number Description

253640 Probe holder/guide kit; includes probe holder and guide for 
1.8 mm outer diameter probes.

253641 Probe holder/guide kit; includes probe holder and guide for 
1.5 mm outer diameter probes.

253642 Probe holder/guide kit; includes probe holder and guide for 
1.3 mm outer diameter probes.

253643 Probe holder/guide kit; includes probe holder and guide for 
2.0 mm outer diameter probes.

253645 Probe holder/guide kit; includes probe holder and guide for 
2.7 mm outer diameter probes.
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Injection Module

To configure the 215 Liquid Handler for automatic HPLC injection, order an 
injection module.

Fraction Collection Valve

To configure the 215 Liquid Handler for fraction collection, order a fraction 
collection valve package.

Part number Description

251511 819 Injection Module

251551 845Z Injection Module

251552 845ZPREP™ Injection Module

Part number Description

251772 215 Low Pressure Valve Package (High Mount), includes low 
pressure valve, valve mounting assembly, and plumbing 
package required to plumb a 215 Liquid Handler/819 
Injection Module as a fraction collector. For flow rates up to 
20 mL/min.

251773 215 Prep FC Package (High Mount), includes valve, valve 
mounting assembly, and plumbing package required to 
plumb a 215 Liquid Handler/819 Injection Module as a 
fraction collector. For flow rates 20–200 mL/min, use a probe 
with an internal diameter of 0.8 mm or larger.

251774 215 Prep FC Package (Low Mount), valve, valve mounting 
assembly, valve bracket assembly, probe guide foot, and 
plumbing package required to plumb a 
215 Liquid Handler/819 Injection Module as a 
fraction collector. For flow rates up to 200 mL/min.
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Gilson, Inc. and its worldwide network of authorized representatives provide 
customers with the following types of assistance: sales, technical support, 
applications, and instrument repair.

If you need assistance, please contact your Gilson-authorized representative. 
Specific contact information can be found at www.gilson.com. To help us serve 
you quickly and efficiently, please refer to Before Calling Us on page 5-11.
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Technical Specifications

Please be aware of the following before operating the liquid handler.

Changes or modifications to the liquid handler not expressly 
approved by Gilson could void the warranty.

This instrument complies with part 15 of the FCC Rules. Operation is subject to 
the following two conditions: (1) This instrument may not cause harmful 
interference, and (2) this instrument must accept any interference received, 
including interference that may cause undesired operation.

Shielded cables must be used with the liquid handler to ensure compliance with 
the FCC Class A limits.

Technical Specification Definition

Arm Speed >45.7 cm/sec (>18 in/sec) in X dimension

>40.6 cm/sec (>16 in/sec) in Y dimension

Communication Interface RS-232 or GSIOC; Four inputs (contact closure, TTL, or 
open-collector), four relay outputs, and one switched 
+24V DC 1A output

Dimensions (W x D x H) 91 x 61 x 56 cm (36 x 24 x 22 in)*

*Maximum height. Z-arm height is adjustable to 
accommodate vessel heights between 1 and 150 mm 
(dependent on installed Z-arm)

Display Panel 8-character display 

Environmental Conditions Indoor use

Altitude: up to 2000 m

Temperature range: 5°–40°C

Air pressure: 75–105 kPa

Humidity: Maximum relative humidity 80% for 
temperatures up to 31°C, decreasing linearly to 50% 
relative humidity at 40°C

Front Panel START and emergency STOP soft keys

Horizontal Motion Strength X: 5 kg (11 lbs)

Y: 7 kg (15 lbs)
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Injection Carryover <0.1%
Contact Gilson Customer Service to learn what methods and conditions 
were used to obtain this value

Liquid Level Sensing Capacitive or conductive

Locator Plate Capacity Up to seven racks depending on the locator plate and racks 
used; for more information, see Appendix B, Racks

Power Requirements Frequency: 50/60 HZ

Voltage: 100–120 V or 220–240V, mains voltage 
fluctuations not to exceed ±10% of the nominal voltage

Current rating: 2.0A for 100–120 or 1.0A for 220–240V

Probe Positioning 
Performance

Accuracy:

±0.5 mm in X/Y dimensions

±1 mm in Z dimension

Repeatability:

±0.25 mm in X/Y/Z dimension

Probe Rinse Probe rinsing occurs through a dedicated rinse station for 
rinsing the inside and outside of the probe

Optional inserts for shallow pocket, deep pocket, and 
flowing rinse

Reproducibility Liquid Handling 1.37% CV with 50 μL of water

Injection
<0.9% CV with 1 mL syringe and 
total loop filling method

Contact Gilson Customer Service to learn what methods and conditions 
were used to obtain the values

Safety Approvals/ 
EMC Compliance

Certified to UL, CSA, CE, and C-Tick Safety/EMC standards

Sampler Type X/Y/Z with stationary rack design

Software Gilson TRILUTION® Software

Technical Specification Definition
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Syringe Capacity / Flow Rates
Syringe Size Maximum Flow Rate 

for Water

100 μL 3.37 mL/min

250 μL 8.43 mL/min

500 μL 16.87 mL/min

1000 μL 33.75 mL/min

5000 μL 100.00 mL/min

10000 μL 100.00 mL/min

25000 μL 100.00 mL/min

Syringe Pump Internal integral high-precision single piston syringe pump

Vertical Punch Strength 5 kg (11 lbs)

Volumetric Accuracy Liquid Handling: 99.7% with 50 μL of water
Contact Gilson Customer Service to learn what methods and conditions 
were used to obtain this value

Weight 40 kg (89 lbs)

Technical Specification Definition
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Installation 2

This chapter takes you through the steps for setting up your 215 Liquid Handler, which includes:

• Locator Plate Installation

• Armlock Removal

• Z-Arm Installation

• Probe Installation

• Syringe Installation

• Plumbing Connections

• Rack Setup

• Final Z-Arm Adjustment

• Rear Panel Connections

tubing
support

rod

cable 
support rod

Z-arm

X-arm

Z-axis

X-axis

front
panel

syringe
pump

rack

rinse
station locator

plate

Y-axis
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The locator plate serves two functions:

• Positions the racks and accessories that fit onto the bed of the liquid handler.

• Contains liquid spills, such as those caused by overflowing vessels.

The locator plate and its four mounting screws are shipped in a separate box with 
the liquid handler’s accessories. 

To install the locator plate onto the instrument bed:

1 Make sure the locator plate’s rinse station base is at the rear of the 
instrument. The locator plate will only install in this orientation.

2 Align the four corner holes of the locator plate with the four holes on the 
instrument bed and lower the plate onto the bed.

3 Using a Phillips screwdriver, secure the locator plate using the four mounting 
screws.

pins to secure
rinse station base(s)

holes to secure
locator plate
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Armlock Removal

The armlock on the liquid handler secures the Y-arm during shipment. You must 
remove the armlock prior to installing the Z-arm and operating the instrument. If 
the armlock is not removed, the liquid handler cannot move in the X direction. 
This results in an error state during operation.

If you need to move the liquid handler, always reinstall the 
armlock. This safeguards against mechanical damage.

To remove the armlock:

1 Remove the cardboard label in front of the armlock.

2 Using the 9/64" ball driver, loosen the tensioning screw that immobilizes the 
Y-arm.

3 Using the 9/64" ball driver, remove the two remaining screws that hold the 
armlock in place.

4 Remove the armlock and store it and the ball driver for future use.

armlock

tensioning
screw securing 

screwY-arm
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Follow these steps to install the Z-arm:

1 Locate the Z-arm and the Z-height adjustment tool that was shipped with the 
Z-arm.

2 Locate the Z-arm mounting bracket on the Y-arm and then slide it forward for 
easier access to the mounting screw.

3 Using a Phillips screwdriver, loosen the mounting screw. (Turn 
counterclockwise to loosen.)

4 Partially pull out the bracket. Do not remove completely.

5 Place the Z-arm into the mounting bracket. Insert one side of the Z-arm into 
place at a time.

6 Tighten the mounting screw on the Z-arm mounting bracket, but leave it 
loose enough so that the Z-arm can slide up and down.

Z-height
adjustment tool

Z-arm

mounting
screw
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7 Place the Z-height adjustment tool on one of its ends near the center of the 
locator plate (if necessary, remove any racks or accessories before doing this).

8 Manually move the arm so the Z-arm is centered over the Z-height 
adjustment tool.

9 While holding Z-height adjustment tool flat against the locator plate, use the 
other hand to lower the Z-arm until it lightly rests on the adjustment tool.

10 Tighten the screw on the mounting bracket until the Z-arm is secure. 

11 While holding the adjustment tool in place, slide the Z-arm off the tool. 
Ensure that the bottom of the Z-arm lightly rubs against the adjustment tool 
as it moves.

12 Note the installed height of the Z-arm using the graduated scale located on 
one side of the arm and note it on this page. This clamp height is required 
when setting up parameters for the Z Height in the 215 Setup Utility as 
described on page 3-14.

13 Store the Z-height adjustment tool.

Z-height adjustment tool

Z-arm

Z-arm

use top of mounting
bracket as scale reference

scale
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Use the two Phillips screws to attach the mounting bracket and cable support 
rod to the rear of the X-arm extrusion.

Z-Arm Connection

Plug the Z-arm control cable into the back topside of the control cabinet. The 
control cable should be tucked into the groove located in the top of the X-arm 
extrusion. The retaining clip that is already on the control cable should be 
snapped onto the top of the cable support rod. Refer to diagram below.

The control cable is correctly installed when the arm is extended to the extreme 
X and Y direction and the cable has enough slack.

retaining
clip

cable
support

rod

screws

mounting
bracket

X-arm
extrusion

plug in 
cable

tuck 
cable into
extrusion

Z-arm control cable

clip cable to
support rod

cable
support

rod
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Probe Installation

There are different probes available for use on the 215 Liquid Handler. 
Depending upon the application, purchase the appropriate probe and 
probe holder/guide kit. When installing the probe, probe holder, and 
probe guide, refer to the following procedures and diagram that shows where 
they are installed on the liquid handler.

Install the Probe Guide

The probe guide is installed on the top of the Z-foot.

1 Place the probe guide into the opening in the top of the Z-foot.

2 Use the two Phillips screws to secure the probe guide to the Z-foot.

Install the Probe Holder

To install the probe holder, screw it into the bottom of the isolation probe holder.

Install the Probe

Insert the probe into the top of the isolation probe holder and pull it through the 
holder until the tip of the probe is in the probe guide.

1/4"-28 fitting

transfer
tubing

isolation
probe holder

probe holder

probeprobe guide
Z-foot

LLD cable
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To install the liquid level detection (LLD) cable:

1 Plug the quick connector into the socket located on the Z-arm.

2 Place the metal slot end of the cable over the metal tab on the isolation probe 
holder. 
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Syringe Installation

If your liquid handler has a built-in syringe pump, the piston operating rod will be 
shipped in the down position. If the rod is not in the down position, please refer 
to the instructions on changing a syringe in Chapter 4, Maintenance. Those 
instructions detail how to lower the rod.

The following procedure is important for correct syringe piston 
alignment. Improper alignment may cause premature piston seal 
failure.

1 Remove the valve and syringe from their packages.

2 Lubricate the piston with diluent to reduce piston seal friction during syringe 
installation.

3 Loosely screw the syringe into the valve. Do not fully tighten.

4 Loosely attach the valve to the syringe pump with the supplied screws.

5 Pull down the piston so it comes into contact with the piston operating rod 
and then firmly tighten the piston holding screw.

6 Fully tighten the valve screws to secure the valve.

7 Fully tighten the syringe to the valve.

Note: Remember the size of the syringe you are installing for later software 
configuration. (You can write the size in the margin here for reference.) See 
Syringe Options on page 3-10.

to inlet tubing to transfer tubing

valve screw
valveto vent tubing

syringe

piston

piston operating rod
holding screw
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Inlet and Vent Tubing Installation

If your liquid handler includes a syringe pump, you received inlet tubing and 
vent tubing.

1 Install the 1/4"-28 fitting of the 2 mm ID tubing (part number 3645357) to the 
inlet side of the syringe pump. Refer to the diagram for Syringe Installation 
on page 2-9, if necessary.

2 Place the filtered end of the assembly into the bottle containing the diluent 
or probe rinse solution.

Note: To lengthen the inlet tubing, use the supplied tubing 
(part number 49948392) and coupling (part number F1410153).

3 Slip the vent tubing (supplied with the syringe valve) onto its port on the 
valve. For the location of the vent, refer to diagram for Syringe Installation 
on page 2-9.
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Transfer Tubing Installation

You can install straight or coiled transfer tubing. Refer to the appropriate 
instructions.

Straight Tubing Installation

Follow these installation instructions if using the straight transfer tubing 
(part number 499421202):

1 Snap three tubing retaining clips onto the tubing support rod. Equally space 
the clips.

2 Install the tubing support rod in its brackets on the control cabinet. Insert the 
front end of the rod into the hole before placing the back end of the rod in its 
cradle.

3 Snap three tubing retaining clips onto the Z-arm control cable. Equally space 
the clips.

4 Snap the tubing into the small grooves on the clips installed on the tubing 
support rod and Z-arm control cable.

Note: You may need to pry the grooves apart using a flatblade screwdriver 
before snapping the tubing into place.

5 Gather any excess tubing into a coil to minimize the length of tubing and 
secure the coil using a twist tie. Position the excess tubing in a convenient 
location near the rear of the liquid handler.

transfer 
tubing support rod

retaining 
clips

1/4"-28 fitting
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syringe pump. Finger-tighten.

7 Connect the other end to the top of the isolation probe holder. Firmly tighten 
this fitting since it holds the probe in place.

1/4"-28 fitting

transfer
tubing

isolation
probe holder

probe holder

probeprobe guide
Z-foot
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Coiled Tubing Installation

Follow these installation instructions if using coiled transfer tubing:

1 Slide the coiled section of the tubing over the tubing support rod. Position 
the tubing so that the shorter piece of straight tubing is toward the 
syringe pump.

2 Install the tubing support rod in its brackets on the control cabinet. Insert the 
front end of the rod into the hole before placing the back end of the rod in its 
cradle.

3 Snap three tubing retaining clips onto the Z-arm control cable. Equally space 
the clips.

4 Snap the long, straight section of the coiled tubing into the small groove on 
the clips that are installed on the Z-arm control cable.

Note: You may need to pry the grooves apart using a flatblade screwdriver 
before snapping the tubing into place.

5 Connect one end of the transfer tubing to the transfer tubing side of the 
syringe pump. Finger-tighten.

6 Connect the other end to the top of the isolation probe holder. Firmly tighten 
this fitting since it holds the probe in place. (Refer to diagram on page 2-12.)

1/4"-28 fitting

transfer
tubing

support
rod

retaining
clip
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Clean the probe using the rinse station. To eliminate liquid cross contamination, 
the rinsing procedure pumps an excess volume of diluent or probe washing 
solution through the probe and out into the rinse station. The small diameter of 
the rinse station inserts allow the outside of the probe to be washed along with 
the inside.

There are three types of rinse station inserts available for the liquid handler:

• Shallow-pocket 
insert - This is a 
closed bottom rinse 
insert that is used for 
applications where 
the probe is only 
immersed in a few 
millimeters of the 
sample.

• Deep-pocket insert - 
This is a closed 
bottom rinse insert. 
This type of insert 
allows for a deeper 
insertion of the 
probe into the rinse 
well resulting in a 
greater area of the 
outside of the 
probe to be rinsed.

• Flow-through insert - This insert is used in applications where a rigorous wash 
of the probe’s exterior is required. A second source of liquid is pumped to the 
rinse station when this insert is used.

It may be necessary to vary the types and volumes of probe wash solutions to 
most efficiently eliminate carryover of particular compounds. Generally, the 
smaller the volume of probe wash solution used, the faster your automated 
liquid handling protocol.

shallow pocket
insert

deep pocket
insert

flow-through
insert

Cross sections of rinse inserts
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Install the Rinse Station

The base of one rinse station is shipped already secured to the locator plate and 
is located at the rear of the locator plate. The locator plate can hold an optional 
second rinse station or you can move the rinse station base to the alternate 
location.

Note: If you purchased the optional 6-position locator plate, the rinse station 
base is located in the center rear of the locator plate and there are two additional 
(alternate) rinse station locations. 

Before installing the rinse station, make sure the locator plate has been properly 
installed with the installed rinse station base located at the rear of the instrument 
bed.

Gilson recommends that the rinse station be installed so that its tube fittings are 
pointing toward the rear of the liquid handler. That orientation is the one 
shipped from the factory.

rinse station
base

optional rinse
station location
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1 Align the triangle of the housing to the base.

2 Insert the housing into the base.

3 Press down and turn 60 degrees. The rinse station is secure when you feel the 
housing snap into place.

4 If satisfied with the standard orientation, follow steps 5, 6, and 7. See Change 
the Orientation (Optional) on page 2-17 if the current location of the waste 
tubing fittings will obstruct the installation of non-standard racks or other 
accessories.

waste tubing
fittings

rinse station
base

rinse 
station

base
(view from side)

waste tubing
fittings

(inlet tubing optional; used
with flow-through rinse insert)

to rinse station

to waste bottle

rinse station insert

rinse station
housing
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5 Install the rinse station insert by pressing the insert down into the housing 
until it snaps into place. You may want to lubricate the o-ring on the rinse 
station insert with water before pressing it into the housing.

6 Connect the waste tubing to the rinse station housing by twisting the tubing 
onto the barbed connectors on the rinse housing until secure.

7 Connect the other end of the waste tubing to the two-liter waste bottle. The 
waste bottle lid has a matching quick connect fitting that mates with the 
tubing’s quick connect fitting.

Note: Make sure the waste bottle is placed in a location that is lower than the 
instrument bed.

Change the Orientation (Optional)

To reorient the direction of the rinse tube fittings:

1 Press down on the rinse station housing.

2 Rotate the housing 120 degrees clockwise or counterclockwise. The housing 
is secure when you feel it snap into place.

3 Install the rinse station insert by pressing the insert down into the housing 
until it snaps into place. 

4 Connect the waste tubing to the rinse station housing by twisting the tubing 
onto the barbed connectors on the rinse housing until secure.

5 Connect the other end of the waste tubing to the two-liter waste bottle. The 
waste bottle lid has a matching quick connect fitting that mates with the 
tubing’s quick connect fitting.

Note: Make sure the waste bottle is placed in a location that is lower than the 
instrument bed.
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The liquid handler is equipped to locate Code 20-, 30-, 200-, 300-, and 500-series 
racks. See Appendix B, Racks for a list of racks available for the liquid handler.

Depending on the racks to be used, refer to the appropriate procedures.

Note: If the optional 6-position locator plate is installed and racks are placed in 
the far right or left positions of the plate, the liquid handler cannot access all of 
the tubes in the racks. The far right and left positions are for installing two Gilson 
818 AutoMix modules onto the liquid handler. Refer to the 818 AutoMix 
User’s Guide for AutoMix and rack placement instructions. 

Code 20- or 30-Series Racks

If all your racks are Code 20- or 30-series racks, follow the steps below.

Note: This configuration is not available for a 6-position locator plate.

1 Install a locator tray (TRAY FOR 7 CODE 20- OR 30-SERIES RACKS, part number 
2504627) onto the locator plate of the liquid handler.

• For Code 20-series racks, the handles face the front.

• For Code 30-series racks, the hose fittings should face the back.

2 Position each rack onto the locator tray. Install up to seven racks using this 
tray.

locator tray

Code 20- or 30- series rack

locator plate
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Code 200-, Code 300-, and Code 500-Series Racks

If all racks are Code 200-, 300-, or  500-series racks, place them directly onto the 
locator plate:

1 Orient the rack so that the code number (for example, 200) is facing forward.

2 Fit the rack on the locator plate so that the slots and holes on the underside 
of the rack align with the pins on the locator plate.

Code 200- or 300-Series and 20- or 30-Series Racks

To use a combination of Code 200-or 300-series and 20- or 30-series racks on the 
locator plate:

1 Install each Code 200-or 300-series rack as described previously.

2 For each Code 20- or 30-series rack, place an adapter plate onto the 
locator plate. Fit the plate so that the slots on the adapter plate align with the 
pins on the locator plate.

3 Place the 20- or 30-series rack onto the adapter plate.

Code 20- or -30 series rack

adapter
plate

Code 200- or 
300-series rack

locator plate

-
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Follow these steps to verify that the Z-arm has been clamped high enough for the 
configuration:

1 Manually move the arm within the working area of the locator plate.

2 Verify that the arm passes approximately 5 mm above the top of the tallest 
vessel in a rack and above the rinse station.

3 If the arm passes freely and is not obstructed, continue the installation by 
making rear panel connections as described in the next section.

If the arm does not clear vessels or the rinse station:

a) Loosen the mounting screw so that the Z-arm can move up and down.

b) Raise the Z- arm up to clear the vessels and rinse station by a minimum of 
5 mm.

c) Tighten the screw on the mounting bracket until the Z-arm is secure. 

4 Note the installed height of the Z-arm using the graduated scale located on 
one side of the arm and note it on this page. Be sure to enter this new clamp 
height when setting up parameters for the Z Height in the 215 Setup Utility 
as described on page 3-14.

Z-arm

use top of mounting
bracket as scale reference

scale
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Rear Panel Connections

Rear Panel Diagram

1 Input/Output ports

2 Gilson Serial Input/Output 
Channel (GSIOC) port

3 Keypad port (not used)

4 RS-232 port

5 Fuse drawer

6 Power switch

7 Power receptacle

8 SW1 (unit ID) selector

9 SW2 (control) selector
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You can use the input and output contacts found on the rear panel of the 
liquid handler to control peripheral devices. Refer to the Rear Panel Diagram on 
page 2-21 for the location of the input/output ports.

Inputs

The input terminal block of the liquid handler has four contacts. All of the inputs 

are paired, and each pair includes a GROUND reference ( ).

The contact input pairs are labeled A–D.

A contact is connected if it has a short across the input or is held low by a TTL 
output or other device.

Never connect voltages higher than 5V DC to an input. When using TTL signals, 
be sure to match GROUND connections.

Outputs

The output terminal block has five contacts. All of the outputs are paired.

Pins 1 and 2 supply ground and a +24V DC output. Do not use this output unless 
the receiving device can accept 24V power.

Outputs labeled 1–4 are paired, isolated-relay contact closures.

Make Connections

The following are needed to make connections:

• terminal block connectors

• 2-conductor cable (22 - 30 gauge for each wire)

You can purchase a 6-foot piece of suitable cable (part number 709910206) 
or a package of 5 cables with identification markers (part number 36078155) 
from Gilson.

• wire insulation stripper

• small-blade screwdriver
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To make connections using the 2-conductor cable:

1 Cut the cable into pieces of appropriate length.

2 Strip about 0.25 cm of insulation from each end of 
the cable.

3 Locate the appropriate green terminal block 
connector in the accessory package. The connector 
for inputs has eight terminals while the one for 
outputs has ten.

4 Insert each wire into the appropriate terminal on the terminal block 
connector. Push the wire all the way in and then tighten its corresponding 
pin screw.

Note: When making connections, be sure to maintain the correct orientation 
of the connector relative to the port. This is especially important if making 
connections to the +24V DC output.

5 Connect the terminal block connector to the liquid handler. The wires will be 
facing left and the pin screws will be facing you as you look at the rear of the 
instrument. Push the connector in as far as it will go. It is designed to fit 
snugly into its receptacle.

6 Connect the opposite ends of the wires to the other device(s). Be sure to 
match GROUND connections.

7 Label each cable to identify the purpose of the connection.

RS-232 Port

The RS-232 port is used to transfer information between the liquid handler and a 
computer. For the location of the RS-232 port, refer to the Rear Panel Diagram 
on page 2-21.

To connect your computer to the liquid handler, you need an RS-232 cable.

Connect the RS-232 Cable

Be sure your computer is turned off before making any connections.

Attach the 25-pin, male end of the RS-232 cable to the RS-232 port located on 
rear panel of the 215 Liquid Handler. Tighten the retaining screws.

Attach the female end of the RS-232 cable to the computer’s RS-232 serial 
communications port. Tighten the retaining screws.

terminal block 
connector

2-conductor
cable

to peripheral
equipment
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Use the GSIOC cable to link other instruments to the liquid handler and control 
all from one computer. A GSIOC cable has two 9-pin female connectors and one 
9-pin male connector.

The following diagram shows the cabling connections between a computer, 
liquid handler, and GSIOC module.

Gilson
module

Gilson
module

GSIOC
cables

RS-232 cable

to computer
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Connect the female connector, located individually at one end of the cable, into 
the GSIOC port of the liquid handler. Tighten the retaining screws. (Refer to 
diagram below.)

Connect the other female connector, located on the same end as the male 
connector, to the Gilson module. Tighten the retaining screws.

If you are connecting more than one Gilson module, use the male connector to 
attach an additional GSIOC cable. Use the female connectors to connect each 
Gilson module.

Cables should be arranged in a linear fashion. Any “Y-branching” from the main 
GSIOC cable may increase noise.

SW1 (Unit ID) Selector

Use the SW1 selector to choose a different unit ID. Refer to the Rear Panel 
Diagram on page 2-21 for the location of the selector.

The unit ID identifies the liquid handler to Gilson software packages that can 
issue GSIOC commands to the liquid handler.

The unit ID is set to 22. There is no need to change this number unless it is the 
same as that assigned to another Gilson instrument that’s also connected along 
the GSIOC.

To change the unit ID:

1 Gently insert a small flat blade screwdriver into the SW1 selector on the rear 
panel and turn it.

2 Align the white dot with one of the indicated numbers. The unit ID is 20 plus 
the selected number.

9-pin female 
connector; 
connect to 
liquid handler

9-pin female connector;
connect to interface module

or GSIOC cable for linking
additional GSIOC modules

9-pin male connector; 
connect to GSIOC cable 

for linking additional 
GSIOC modules
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Use the SW2 selector to set the liquid handler for GSIOC control. For the location 
of the selector, refer to the diagram on page 2-21.

The SW2 selector is set to 8, indicating that the liquid handler is set for RS-232 
control.

Change the setting to 0 (zero) if the liquid handler is connected via the GSIOC to 
a Gilson system and is being controlled by Gilson control software.

To change the control setting:

1 Gently insert a small flat blade screwdriver into the SW2 selector on the rear 
panel and turn it.

2 Align the white dot with one of the indicated numbers.

Fuse Installation

You received the liquid handler without any fuses installed. 

To install the fuses:

1 Locate the accessory package containing the fuse drawer appropriate for 
your line voltage.

2 Locate the accessory package containing the 2.5A "T" Slo-Blo (5 x 20 mm size) 
fuses.

3 Install the fuse(s) into the fuse drawer. The fuse drawer for 100/120V accepts 
one fuse. The fuse drawer for 220/240V accepts two fuses.

4 Insert the fuse drawer into its receptacle in the liquid handler. For the 
location of the receptacle, refer to the Rear Panel Diagram on page 2-21.

Fuse Installation for
100/200 voltage

Fuse Installation for
220/240 voltage
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Power Cord Connection

Locate the appropriate power cord for your line voltage. 

Use the power cord to connect the liquid handler to a power source.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Gilson 215 Liquid Handler User’s Guide 3-1

Operation 3

Both TRILUTION® LC Software and TRILUTION® LH Software provide programmed control of the 
215 Liquid Handler. 

This chapter provides the following information:

• A description of the Front Panel of the liquid handler

• How to Start Up the liquid handler

• How to use the 215 Setup Utility

• Instructions for using the 215 Priming Utility

• How to Test the Liquid Handler’s Contacts
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The front panel of the liquid handler contains a Start button, Stop button, display, 
and power indicator light.

Start Button

The Start button can be used to home the XYZ-arm when the liquid handler is 
first powered up or when the motors for the XYZ-arm have been relaxed. When 
pressed, the yellow display light is turned on.

Stop Button

The Stop button is a large touch-sensitive pad that can be used to stop the 
liquid handler and also relax the motors for the XYZ-arm so that you can easily lift 
the probe and move the arm. When pressed, the yellow display light is turned off.

In a situation where an emergency stop is required, pressing the Stop button 
immediately stops the liquid handler. The stop button is designed to be sensitive 
enough that if you just brush it with your hand, it activates.

Start display

power
indicator
light

STOP
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Display

The 8-character display shows the current status of the liquid handler and any 
error codes as they are encountered. Your program can also contain instructions 
for showing 8-character messages on the display when the program is run.

Refer to Chapter 5, Troubleshooting for a list of current error codes and required 
actions.

Power Indicator Light

This indicator becomes lit when you turn on power to the liquid handler using 
the power switch located on the rear panel. Refer to the Rear Panel Diagram on 
page 2-21, if necessary.
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To start the liquid handler:

1 Make sure that the armlock has been removed.

2 Make sure that the liquid handler is connected to a power source.

3 Turn on the liquid handler using the power switch located on the rear panel. 
Refer to the Rear Panel Diagram on page 2-21, if necessary. The power 
indicator light on the front panel illuminates.

When power is turned on, the liquid handler beeps and displays the current 
version of its installed firmware. This message appears for about one second 
before the display returns to a blank state.

In order to determine what PROM version is installed in your liquid handler, 
you may need to turn the unit off then on again and watch the display for the 
version number to appear.

4 After the liquid handler powers up, press the Start button. This initiates the 
homing sequence that allows the liquid handler to determine its mechanical 
reference positions. The sequence takes approximately one minute to 
complete.

While the homing sequence progresses, the display shows Homing. When 
the sequence completes, the display is blank.
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215 Utility Programs

The 215 Utility Programs CD-ROM, provided with your liquid handler, supplies 
the following utility programs:

215 Setup Utility - Specifies configuration parameters for the liquid handler.

215 Priming Utility - Primes the transfer tubing.

215 Contact Test Utility - Enables you to test contact connections.

215 Injection Z-Height Utility - Enables you to adjust the height of the Z-arm 
when used with an 819 Injection Module.
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Follow the on-screen instructions.

When prompted, restart the computer.

1 2

3 4

5 6
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Start Utility Programs

Windows® 2000/XP

For communication to occur, the 215 Liquid Handler must be connected via an 
RS-232 or GSIOC to RS-232 connection to the computer. For information about 
making these connections, see Chapter 2, Installation.

To start a utility program, click START | ALL PROGRAMS | 
GILSON APPLICATIONS | 215 Liquid Handler and then select a utility program 
from the list.

Help

On-line help is included for the 215 Utility Programs. The on-line help describes 
commands and dialogs displayed in the software and the procedures needed to 
perform tasks.

Click  to display help about the dialog box.
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The liquid handler comes with its configuration set by Gilson. Configuration 
information is stored in the non-volatile memory of the liquid handler. Prior to 
using the liquid handler for the first time, it is important to review and adjust the 
default configuration to make sure it is correct for your application.

The following pages describe how to configure a liquid handler using the 215 
Setup Utility. Refer to the online help for assistance.

The 215 Setup Utility allows you to review and if necessary change the 
configuration options set for the liquid handler. 

When you execute the Utility program from your computer, the following screen 
with menu tabs appears:

Section Described on

Pump Type page 3-9

Syringe Options page 3-10

Rinse Site page 3-11

Liquid Detector page 3-12

Adjust XY page 3-13

Sound and Display page 3-17

Emergency Contact page 3-17

About... page 3-18

Z Heights page 3-14

Home Phase page 3-15

Safety Contact page 3-16

Bearing Life page 3-16
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Pump Type

Use the Pump Type tab to 
set the type of 
syringe pump installed in 
the instrument. If the 
pump type actually 
installed does not match 
the setting indicated here, 
an error will occur during 
operation.

Pump type selections are:

• Blank Front (no syringe pump is installed)

• 1 Syringe

• 8 Syringe (not used for the 215 Liquid Handler)

• Other (for future use)

To store the pump type to memory, click OK.

To display the pump type currently set in the memory, click Cancel.
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Under the Syringe Options 
tab, you indicate the size of 
the installed syringe or 
click the Lower Syringe 
button so you can install a 
new syringe.

Use the option buttons to 
select the correct syringe 
size in microliters. If you do not know the size of the syringe installed, check the 
container in which the syringe was shipped for size information. An incorrect 
setting can cause improper volumes to be aspirated or dispensed during 
liquid handler operation or can cause an error to occur.

To store the syringe capacity to memory, click OK.

To display the syringe capacity currently set in the memory, click Cancel.

Clicking Lower Syringe facilitates replacement of a new syringe by causing the 
syringe piston to move to the bottom of its stroke.

Clicking Raise Syringe facilitates replacement of a new syringe by causing the 
syringe piston to move to the top of its stroke. 
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Rinse Site

The instrument stores the 
location of a rinse site in 
memory. This allows the 
instrument to move to this 
location before homing 
the syringe and prevents 
the spilling of waste liquid 
or rinse diluent.

Depending on the instrument’s configuration, refer to the appropriate 
information below for reviewing and changing rinse site information.

The factory default rinse site is 114.4 mm in X, 3.8 mm in Y, and 100 mm in Z. 
These coordinates are for a rinse station, with a shallow-pocket rinse insert, 
installed on the left-side of a 5-position locator plate. Change the Z coordinate to 
a value from 55 to 65 mm if a deep-pocket insert is installed or to 50 mm if a 
flow-through rinse insert is installed.

If the rinse station has been moved to the right side of the 5-position 
locator plate, change the X coordinate to 473.1 mm. Leave the Y coordinate at 
3.8 mm. Change the Z coordinate to a value from 55 to 65 mm if a deep-pocket 
insert is installed or to 50 mm if a flow-through rinse insert is installed.

If a 6-position locator plate is installed, change the X coordinate to the 
appropriate value, listed below. Leave the Y coordinate at 3.8 mm. Change the 
Z coordinate to a value from 55 to 65 mm if a deep-pocket insert is installed or to 
50 mm if a flow-through rinse insert is installed.

To store the rinse site coordinates to memory, click OK.

To display the rinse site coordinates currently set in the memory, click Cancel.

Rinse station location X coordinate

Left (factory default) 169.3 mm

Center 288.9 mm

Right 408.0 mm
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The Liquid Detector tab 
allows you to adjust the 
sensitivity of liquid 
detection. The factory 
default setting is 6%.

Raising the percentage 
suppresses false liquid 
detection while lowering 
the percentage increases sensitivity for situations where liquid is harder to 
detect. By lowering the probe so it touches the liquid for one of your samples, 
you can manually test the current sensitivity of the liquid detection. In this 
manner, you can observe the amount of change you might expect with each 
sample.

To store the sensitivity setting to the liquid handler's memory, click OK.

To display the sensitivity setting currently set in the liquid handler's memory, 
click Cancel.
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Adjust XY

The Adjust XY tab allows 
you to test whether the 
instrument is properly 
adjusted and to make 
minor adjustments to the 
X- and Y-axis offsets if 
needed. You may need to 
use the options under this 
tab if the probe is not accessing the injection port of the injection module 
installed or the vessels in the installed racks.

The X offset and Y offset text boxes display the current offsets stored in the 
instrument’s memory.

To determine if the probe needs to be adjusted in the X or Y direction:

Select the model of the injection module that is on your 215 or select other for a 
user-defined test point. The default X,Y coordinates are shown next to the model 
number.

Injection Module Coordinates

819: 

X-coordinate: 544.0 mm
Y-coordinate: 3.8 mm

If the model 819 is not installed next to the right support 
use the following coordinates:
X coordinate: 351.1 mm
Y coordinate: 1.3 mm

841:
X-coordinate: 475.3 mm
Y-coordinate: 3.8 mm

849:
X-coordinate: 336.1 mm
Y-coordinate: 3.8 mm

other:
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Use the Z Heights tab to 
identify the size of the 
installed Z-arm and the 
height at which the Z arm is 
clamped.

Use the option buttons to 
select the correct tower 
height in millimeters. 
Setting the tower height of the Z-arm determines the amount of possible travel 
in the Z-axis. If you do not know the height of the tower installed, check the Z-arm 
for a label or the container in which the tower was shipped for height 
information. An incorrect setting could cause the probes to be damaged during 
liquid handler operation.

The Z-arm can be clamped at an adjustable height over the locator plate. You can 
set this height so that the liquid handler is able to properly find heights that you 
specify. Type the clamp height in millimeters. A clamp height of 0 mm means the 
bottom of the Z-arm is flat on the locator plate.

To store the selected Z-height settings to the liquid handler's memory, click OK.

To display the Z-height settings currently set in the liquid handler's memory, click 
Cancel.
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Home Phase

Use the Home Phase tab to 
display the current X and Y 
phase of the instrument.

Clicking Start causes the 
liquid handler to perform 
the phase procedure. This 
procedure consists of the 
liquid handler homing 
itself 10 times.

The liquid handler finds out where home is located by "feeling" for the back and 
left walls of the unit. The liquid handler expects to find these walls in the same 
place each time. If it does not, you will get an error. If this error was caused by an 
obstruction, just clear the obstruction and try again. If the problem does not clear 
or if a change is made to the mechanics, you will probably need to repeat this 
option to find the true home location.

Once the process completes, the spreadsheet displays the values generated from 
each phase procedure.

To store the new phases to the memory, click OK.

To display the home phase information currently set in the 215’s memory, click 
Cancel.
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The instrument has 
provisions for connecting 
safety devices that your 
application may require, as 
long as they present a 
contact closure or TTL type 
interface. The 
Safety Contact tab allows 
you to specify which input contact is connected to the safety device and what is 
the active state of that device. The function of the safety contact is equivalent to 
pressing the Stop button on the instrument’s front panel.

To use this option, choose one or more of the check boxes and then click OK to 
store the information to memory.

Or, to display the safety contacts currently set in the instrument’s memory, click 
Cancel.

Bearing Life

The Bearing Life tab 
displays the XYZ travel in 
kilometers, the number of 
full strokes performed by 
the syringe pump (if 
applicable). Spring Cycles 
is not applicable to the 
215 Liquid Handler.
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Sound and 
Display

Use the options in the 
Sound / Display tab to 
adjust the brightness of 
the display, sound level, 
and tone.

Clicking Beep tests the 
sound level and tone that are currently selected.

For the LED brightness, you can select a range of 0 through 7 where 0 is the 
dimmest and 7 is the brightest. Default setting is 5.

To store the selected options to memory, click OK.

Or, to display the options currently set in the memory, click Cancel.

Emergency 
Contact

The emergency contact 
option provides for 
sending a signal to a 
peripheral device (such as 
a Gilson 818 AutoMix) 
whenever the 215’s Stop 
button is pressed or safety 
input is activated.

To store changes to the emergency contacts, click OK.

To display the emergency contact(s) currently set in the 215’s memory, click 
Cancel.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Operation 3

3-18 Gilson 215 Liquid Handler User’s Guide

21
5

Se
tu

p
 U

ti
lit

y About...

The About tab allows you 
to indicate the unit ID of 
the instrument being 
configured so the 
215 Setup Utility can 
communicate with that 
instrument.

This tab also lists software 
version and copyright information for the 215 Setup Utility.

The Set Type button allows you to manually set the type of 215 you are using. 
Unless the Non-Volatile RAM has been cleared, this information will appear 
automatically.

Next to the “Model 215 Unit ID” text box you will see the following:

To change this setting, click the drop down menu next to the Set Type button and 
select the appropriate 215 type. Click Set Type to accept the change.

215 = 215vX.XX

215 without pump = 215NOPvX.XX
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215 Priming Utility

The 215 Priming Utility primes your syringe and transfer tubing lines with liquid 
from your syringe pump’s reservoir. Gilson recommends using the 215 Priming 
Utility before using the liquid handler for the first time or if the liquid handler has 
not been used for some time. Using the software will eliminate air in the transfer 
tubing.

Start the Priming Cycle

In the software, indicate a priming speed (in milliliters per minute). Then click on 
the Prime option button. Before priming begins, the liquid handler homes the 
probe and then moves it to the rinse station. When the probe is at the rinse 
station, priming begins.

Pause the Priming Cycle

You can pause the priming cycle at any time by clicking on the Pause option 
button. If a pause is activated while the syringe is in a downward motion, the 
software stops the syringe at the bottom of its stroke. If a pause is activated while 
the syringe pump is in an upward motion, the software stops the syringe at the 
top of its stroke. When you pause the priming cycle, ‘Pause’ appears on the 
liquid handler’s display. To continue the priming cycle, click on the Prime option 
button.

Stop the Priming Cycle

To terminate priming, click the Stop option button. This causes the syringe to 
home.

Exit the Software

Click Done to close the software.
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The 215 Contact Test Utility program allows you to activate output contacts that 
determine if the correct contact connections are made to peripheral devices 
controlled by the liquid handler. It also identifies the state of input contacts.

Before using this program, you need to connect the peripheral device’s inputs to 
the appropriate output pair on the liquid handler. If necessary, refer to 
Input/Output Ports on page 2-22 for information on making contact 
connections.

While the 215 Contact Test Utility program is running, the program continuously 
displays the state of outputs and inputs. When an output contact is active, a 
check displays next to the output contact and when inactive, it remains blank. 
For example, to activate output contact 24V, click the toggle box next to 24V. A 
check displays indicating 24V is active. Click the toggle for an active output 
contact and it becomes inactive.

To exit the software, click Done.
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To obtain optimum performance and maximum life from the 215 Liquid Handler, it is important to keep 
the instrument well-maintained.

The 215 Liquid Handler is intended to be used in a laboratory environment by trained technical 
personnel.

This chapter contains the following information to help you to maintain your liquid handler:

• Helpful Hints

• Cleaning

• Replace Parts

• Check Position Alignment

• Transport the Liquid Handler
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In order to keep your liquid handler at peak performance, Gilson recommends 
that you do the following:

• Change or clean the piston seals and tubing regularly to maintain maximum 
syringe pump performance.

• Do not cycle the syringe pump without fluid. Doing this causes excessive 
piston seal wear.

• Flush the syringe pump, probe housing, and rinse stations daily with distilled 
or deionized water. On a weekly basis, flush these instruments with a 10% 
solution of bleach or weak detergent.

• If bubbles remain in the syringe after priming, clean the syringe with alcohol.

• Check periodically to ensure that all fittings are tight.

• Check that the syringe is tight in the syringe pump valve fitting.

• Wipe up all spills immediately.

• Cold fluids may cause leakage; warm fluids to room temperature before 
running them through the system.
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Cleaning

Clean the Liquid Handler

The liquid handler should be cleaned occasionally using a dry, clean cloth. Or, if 
necessary, use a cloth dipped in soapy water. If liquid is accidentally spilled on the 
liquid handler, wipe the instrument using a dry, clean cloth.

Clean the Syringe

If your liquid handler is equipped with a syringe pump, it may be necessary to 
clean the syringe. Cleaning the syringe is needed when some or all of the 
following occurs:

• Corrosive or hazardous liquids have been pumped

• Possible back flow of liquids into the waste tubing

• Leakage

• Aspiration of samples or reagents into the syringe

To clean the syringe, follow the procedures on the next page and use the diagram 
below as a reference.

to inlet tubing to transfer tubing

valve screw
valve

to vent tubing

syringe

piston

piston operating rod
piston holding screw
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The following procedures use the 215 Setup Utility. 

To remove the syringe:

1 Disconnect the syringe piston from the piston operating rod by unscrewing 
the piston holding screw on the underside of the rod.

2 Start the 215 Setup Utility, described on page 3-8.

3 Select the Syringe Options tab. The option button for the installed syringe 
size is selected. Click Lower Syringe. This causes the piston operating rod to 
descend as the syringe pump aspirates from the reservoir. The syringe pump 
will stop at the bottom of its stroke, switching the valve to the outlet position.

4 After the syringe has been lowered, unscrew and remove the syringe from 
the valve.

Clean the Syringe

After the syringe has been removed, it can be cleaned:

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

1 Place the syringe in a beaker containing methanol. Then aspirate and 
dispense several volumes of methanol through the syringe.

2 Place the syringe in a beaker containing distilled or deionized water. Then 
aspirate and dispense several volumes of water through the syringe.

3 Hold the syringe housing in one hand. Clean the syringe using a 
non-abrasive cloth dampened with alcohol. Remove the piston and clean the 
piston with a non-abrasive cloth dampened with alcohol.

4 Dry the syringe and piston using a clean, lint-free cloth.

Reinstall the Syringe

When the syringe is clean, reinstall it:

1 Lubricate the piston with reservoir solvent to reduce friction on the piston 
seals during reinstallation.

2 Fully tighten the syringe into the valve.
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3 In the 215 Setup Utility, select the Syringe Options tab. The option button for 
the installed syringe size is selected. Click Raise Syringe. This causes the 
piston operating rod to ascend. The syringe pump will stop at the top of its 
stroke.

4 Firmly tighten the piston holding screw to secure the syringe piston.

Clean the Fluid Path

Depending upon your use of the liquid handler, it may be necessary to flush the 
entire fluid path. When flushing the fluid path it is recommended to use a volume 
that is equal to ten times the syringe volume plus the transfer tubing volume.

flush volume = (10 * syringe volume) + transfer tubing volume

It’s important to clean the fluid path if you won’t be using the liquid handler for 
a while or if you’re using a solution with a high salt concentration for a 
probe wash or as a diluent. 

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

Refer to the instructions below:

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path with 30% ethanol. The fluid path has now been cleaned 
appropriately for weekend storage (or longer).

3 Prime and flush the fluid path with distilled or deionized water before 
running applications.

Cleaning Methods

Depending on the samples or reagents that come into contact with the 
fluid path, you may need to vary your cleaning methods accordingly. Use the 
following cleaning protocols as references and make any changes to them as 
required for the samples and reagents being pumped for your application.
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proteins and peptides:

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path using a weak detergent solution.

3 Pause the priming sequence.

4 After 30 minutes, resume flushing and priming the fluid path using distilled 
or deionized water to pump the remaining detergent from the tubing into a 
waste container. 

5 When you’re satisfied that the entire fluid path has been flushed with water, 
end the priming sequence. 

Acidic compounds, basic compounds, or salt solutions - Follow this procedure 
if the fluid path is in contact with acidic compounds, basic compounds, or salt 
solutions:

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Flush the fluid path using a 0.1N NaOH solution. 

3 Pause the priming sequence.

4 After 10 minutes, resume priming the fluid path using distilled or deionized 
water. Prime until the fluid path has been flushed with water.

5 Pause the priming sequence.

6 Prime the fluid path using a 0.1N HCl solution. 

7 Pause the priming sequence.

8 After 10 minutes, resume priming the fluid path using distilled or deionized 
water. 
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Biological fluids - Follow this procedure if the fluid path is in contact with 
biological fluids such as blood products:

To prevent injury, observe good laboratory practices when 
handling solvents. Know the physical and chemical properties. 
Refer to the Material Safety Data Sheets for the solvents used.

1 Prime the fluid path with distilled or deionized water.

2 Make a solution of 10% bleach by adding one part of commercial bleach to 
nine parts of water.

3 Flush the fluid path using the bleach solution.

4 Pause the priming sequence.

5 After 30 minutes, resume priming the fluid path using distilled or deionized 
water to pump the remaining bleach solution from the tubing into a waste 
container. 

Clean the Valve

Clean the syringe pump’s valve with a nonabrasive cloth after any of the 
following situations have occurred:

• Corrosive or hazardous liquids have been pumped

• Possible back flow of liquids into the waste tubing

• Leakage

Remove the Valve

To clean the valve, first remove it from the syringe pump:

1 Disconnect the inlet, transfer and vent tubing from the valve.

2 Disconnect the syringe from the valve.

3 Remove the valve from the front panel by removing the two securing screws.
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1 Hold the valve body firmly in one hand. Using a 17 mm open-ended wrench, 
turn the valve axle guide counterclockwise and separate the two halves.

2 Pull the valve axle away from the valve main body.

3 Separate the ceramic stator from the ceramic rotor.

4 Tap the valve axle guide against a solid level surface to remove the spring and 
PTFE end piece.

Note: Do not remove the ceramic stator from the valve main body.

Clean and Reinstall the Valve

The disassembled parts of the valve can be cleaned using a non-abrasive cloth 
dampened with alcohol.

1 Dry the components using a clean, lint-free cloth.

2 Reassemble the valve parts by reversing the above procedure.

3 Reinstall the syringe and valve.

main body

PTFE seal
ceramic stator

ceramic and 
PEEK rotor

valve axle

PTFE end piece

spring

valve axle guide
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Replace Parts

Tubing

It is important to keep all tubing clean and free of crimps. Tubing that has 
become dirty, blocked or crimped can result in poor accuracy and precision, loss 
of air gap, or the syringe stalling.

Replace both the transfer tubing and inlet tubing as needed. See Appendix A, 
Replacement Parts and Accessories for part numbers for replacement tubing. 
For tubing installation procedures, see Chapter 2, Installation.

Piston Seal

To change the syringe pump’s piston seal, refer to the instructions on the 
following pages. For part numbers for replacement seals, contact your 
Gilson-authorized representative.

100 and 250 μL Syringes

1 Remove the syringe from the pump as described on page 4-4.

2 Slide the piston out of the syringe barrel.

3 Remove the piston seal from the piston rod by carefully pinching the piston 
seal with a pair of pliers and gently pulling the piston seal off the piston rod.

Take care not to damage the end of the piston rod when 
removing the seal. (It is possible to remove the seal by 
pinching it between the thumb and forefinger nails and 
pulling.)

4 Remove any remaining debris of the original piston seal from the end of the 
rod.

5 The 100 μL and 250 μL pistons have a narrow rod that may be damaged if 
handled incorrectly. In order to fit a new piston seal without unduly bending 
the piston rod, undo the Allen screw that secures the piston button to the 
piston rod. Slide the button down the piston rod to within 10 mm of the end 
of the rod where the new piston seal is to be mounted and re-tighten it in 
position. 

6 Put the new piston seal in its recess in the piston seal mounting tool. The 
100 μL and 250 μL piston seals use the same tool. One face of the tool has a 
recess for the 100 μL piston seal, the other face has a recess for the 250 μL 
piston seal. 

piston rod

piston
button

allen 
screw

piston 
seal

mounting
tool
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new piston seal.

8 Remove the piston assembly from the piston seal holder. Slacken the piston 
button and slide it away from the piston rod.

9 Dip the piston seal in distilled water and slide the piston assembly into the 
syringe. 

10 Hold the syringe upright with the threaded end of the syringe resting on a 
flat, clean surface. Slide the piston into the syringe until the piston stops (the 
seal is level with the end of the syringe). 

11 For the 100 μL piston only, insert the support collar as shown on the right. 
The support collar should be replaced after 60,000 strokes.

12 Slide the piston button against the body of the syringe and tighten the Allen 
screw that secures the piston button onto the piston rod.

13 Slide the piston up and down in the syringe five or six times to ensure a 
smooth operation between the piston and syringe.

14 Remount the syringe on the pump as described on page 4-4.

piston button

allen screw

piston rod

support collar

piston seal

syringe barrel

valve screw

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Gilson 215 Liquid Handler User’s Guide 4-11

Maintenance 4
R

ep
lace Parts

500 μL Syringes

1 Remove the syringe from the pump as described on page 4-4.

2 Slide the piston out of the syringe barrel.

3 Remove the piston seal from the piston rod by carefully pinching the piston 
seal with a pair of pliers and gently pulling the piston seal off the piston rod. 

Take care not to damage the end of the piston rod when 
removing the seal. (It is possible to remove the seal by 
pinching it between the thumb and forefinger nails and 
pulling.)

4 Remove any remaining debris of the original seal from the end of the piston 
rod.

5 Put the new piston seal in its recess in the piston seal holding tool. 

6 Turn the tool upside down and place the piston 
assembly as shown in the figure at right.

7 Slacken the piston button and remove it from the 
piston rod. Slide the clamping tool down the 
piston rod and press the two tools firmly against 
each other. A slight rotation of the clamping tool 
ensures a correct fitting.

8 Remove the tools away from the piston 
assembly.

9 Dip the piston seal in distilled water and slide the 
piston into the syringe. 

10 Hold the syringe upright with the threaded end of the syringe resting on a 
flat, clean surface. Slide the piston into the syringe until the piston stops (the 
seal is level with the end of the syringe).

11 Slide the piston button against the body of the syringe and tighten the Allen 
screw that secures the piston button onto the piston rod.

12 Slide the piston up and down in the syringe five or six times to ensure a 
smooth operation between the piston and syringe.

13 Make sure of the presence of the plastic cover when re-mounting the syringe 
on the pump.

14 Remount the syringe on the pump as described on page 4-4.

piston
rod

clamping
tool

piston
seal

piston seal holding tool
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1 Remove the syringe from the pump as described on page 4-4.

2 Slide the piston out of the syringe barrel. 

3 Remove the piston seal from the piston rod by carefully pinching the piston 
seal with a pair of pliers and gently pulling the piston seal off the piston rod.

Take care not to damage the end of the piston rod when 
removing the seal. (It is possible to remove the seal by 
pinching it between the thumb and forefinger nails and 
pulling.)

4 Remove any remaining debris of the original seal from the end of the piston 
rod.

5 Put the new piston seal in its recess in the piston seal holding tool. 

6 Holding the piston rod firmly, gently push the end of the piston rod into the 
new piston seal until the rod is clamped in the piston seal.

7 Remove the piston assembly from the holding tool.

8 Dip the piston seal in distilled water and slide the piston into the syringe.

9 Hold the syringe upright with the threaded end of the syringe resting on a 
flat, clean surface. Slide the piston into the syringe until the piston stops (the 
seal is level with the end of the syringe).

10 Slide the piston button against the body of the syringe and tighten the Allen 
screw that secures the piston button onto the piston rod.

11 Slide the piston up and down in the syringe five or six times to ensure a 
smooth operation between the piston and syringe.

12 Remount the syringe on the pump as described on page 4-4.

piston seal
holding tool

piston seal

piston rod
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5 mL and 10 mL Syringes

1 Remove the syringe from the pump as described on page 4-4.

2 Slide the piston out of the syringe barrel. 

3 Remove the piston seal from the shaft by carefully pinching the piston seal 
with a pair of pliers and gently pulling the piston seal off the shaft. 

Take care not to damage the end of the piston rod when 
removing the seal. (It is possible to remove the seal by 
pinching it between the thumb and forefinger nails and 
pulling.)

4 Remove any remaining debris of the original piston seal from the end of the 
shaft.

5 Insert the new piston seal in the recess of the piston seal holder. Make sure 
that the aperture is facing outward and the O-ring is inside the seal.

6 Place the piston shaft in the piston shaft holder, see figure below.

7 Screw the two parts of the tool together until tight.

8 Unscrew the tool, the piston seal should be correctly seated on the shaft.

9 Dip the piston seal in distilled water and slide the piston into the syringe. 

10 Slide the piston up and down in the syringe five or six times to ensure a 
smooth operation between the piston and syringe.

11 Remount the syringe on the pump as described on page 4-4.

O-Ring piston seal

piston seal holder piston shaft piston shaft holder
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1 Remove the syringe from the pump as described on page 4-4.

2 Slide the piston out of the syringe barrel.

3 Hold the piston seal firmly in one hand and unscrew the seal from the piston 
shaft.

4 Screw a new piston seal on the shaft.

5 Slide the piston into the syringe barrel and complete the piston seal fitting by 
screwing the shaft until the piston seal turns with the piston shaft.

6 Dip the piston seal in distilled water and slide the piston up and down in the 
syringe barrel five or six times to ensure a smooth movement between the 
piston and syringe.

7 Remount the syringe on the pump as described on page 4-4.

Syringe

If necessary, refer to the diagram on page 4-4 while performing the procedures 
below. The following procedures use the 215 Setup Utility.

Remove the Syringe

1 Disconnect the syringe piston from the piston operating rod by unscrewing 
the piston holding screw on the underside of the rod.

2 Start the 215 Setup Utility, described on page 3-8.

3 Select the Syringe Options tab. The option button for the installed syringe 
size is selected. Click Lower Syringe. This causes the piston operating rod to 
descend as the syringe pump aspirates from the reservoir. The syringe pump 
will stop at the bottom of its stroke, switching the valve to the outlet position.

4 After the syringe has been lowered, unscrew and remove the syringe from 
the valve.
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Install the New Syringe

1 Fully tighten the replacement syringe into the valve.

2 Start the 215 Setup Utility, described on page 3-8.

3 Select the Syringe Options tab. The option button for the installed syringe 
size is selected. Click Lower Syringe. This causes the piston operating rod to 
descend as the syringe pump aspirates from the reservoir. The syringe pump 
will stop at the bottom of its stroke, switching the valve to the outlet position.

Note: If you installed a new syringe of a different size than the one you 
replaced, select the new syringe capacity and then click OK to store the 
syringe capacity to memory.

4 Firmly tighten the piston holding screw to secure the syringe piston.

Valve

Remove the Valve

1 Disconnect the inlet, transfer, and vent tubing from the valve.

2 Disconnect the syringe from the valve as described on page page 4-14.

3 Remove the valve from the front panel by removing the two securing screws.

Install the New Valve

1 Re-install the syringe and the replacement valve by following the 
instructions on page page 2-9.

2 Reconnect the inlet, transfer, and vent tubing to the newly installed valve.
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To install a replacement probe:

1 Remove the transfer tubing’s 1/4"-28 fitting connected to the top of the 
isolation probe holder.

2 Grasp the current probe and push it up through the top of the isolation 
probe holder.

3 Verify that the installed probe holder and probe guide are appropriate for 
the probe to be installed. If installing a new probe holder and probe guide:

a) Remove the current probe guide from the opening in the top of the foot 
by unscrewing the two Phillips screws. Then place the new probe guide 
into the top of the foot and secure it using the screws.

b) Remove the current probe holder by unscrewing it from the bottom of 
the isolation probe holder. Then install the new probe holder by 
screwing it into the isolation probe holder.

4 Install the new probe by pushing it through the top of the isolation 
probe holder. Make sure the tip of the probe sits inside the probe guide.

5 Replace and tighten the 1/4"-28 fitting.

probe guideZ-foot

probe

probe holder

isolation
probe holder
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Fuse

A blown fuse may indicate the existence of another problem in the instrument. If 
the replacement fuses blow, do not try additional fuses. Contact your 
Gilson-authorized representative. See Before Calling Us on page 5-11.

To change a fuse, follow these steps.

1 Disconnect the power cord from the power outlet and from the rear panel 
receptacle.

2 Locate the fuse drawer on the rear panel. See page 2-21 if necessary.

3 Insert a small screwdriver into the notch under the fuse drawer.

4 Twist the screwdriver to open and remove the fuse drawer. The fuse drawer 
contains one 2.5A "T" Slo-Blo fuse (5 x 20 mm size) for a 100/120 voltage 
selection. It contains two 2.5A fuses for a 220/240 voltage selection.

5 Remove the old fuse(s) and insert the new fuse(s).

6 Insert the fuse drawer into its receptacle in the liquid handler.

fuse 
drawer

Fuse drawer for 100–120 voltage selection Fuse drawer for 220–240 voltage selection
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The 215 Setup Utility, described in Chapter 3, Operation, allows you to test 
whether the liquid handler is properly aligned and to make minor adjustments to 
the X-axis and Y-axis offsets if needed. For example, after changing the probe, 
alignment should be reviewed. To check the current alignment and make 
adjustments as needed, select the Adjust X&Y tab.

The X offset and Y offset text boxes display the current offsets stored in the 
instrument’s memory.

Select the model of the injection module that is on your Multiple Probe 215 
Liquid Handler (likely an 849 Injection Module) or select other for a user-defined 
test point. The default X,Y coordinates are shown next to the model number.

Injection Module Coordinates

849:
X-coordinate: 336.1 mm
Y-coordinate: 3.8 mm

other:
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Transport the Liquid Handler

When moving the liquid handler to another location or when sending it in for 
service, do not use the Y-arm as a handle. Reinstall the armlock (see page 2-3) and 
always lift the liquid handler from the base.
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Troubleshooting 5

This chapter provides information on the following topics:

• Error Messages

• Mechanical

• Electrical

• Tubing and Syringe Pump

• Liquid Level Detector

• Repair and Return Policies
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Error Description Solution

10 Invalid Pump Type Run 215 Setup Utility to correct the problem.

11 Undefined syringe size Run the 215 Setup Utility to correct the 
problem.

12 Pump not found Contact your Gilson-authorized 
representative.

13 Syringe speed out of range This can be caused by an incorrect syringe size 
setting. Run the 215 Setup Utility 
(Syringe Options tab) to check that the 
correct syringe capacity was selected. If you 
do not know the size of the syringe installed, 
check the container the syringe was shipped 
in for size information.

Or, the requested aspirate or dispense speed 
is too fast for the installed syringe. Refer to the 
table listing the maximum flow rates on 
page 1-13 and then change the speed 
accordingly in the control software.

14 Invalid syringe volume Requested aspirate or dispense volume is too 
large for syringe installed. Modify the syringe 
aspirate and dispense volumes in the 
program controlling the liquid handler. An 
incorrect syringe size setting can also cause 
improper volumes to be aspirated or 
dispensed during operation or can cause an 
error to occur. Run the 215 Setup Utility 
(Syringe Options tab) to check that the correct 
syringe capacity was selected.

15 NV-RAM checksum is invalid • Send the buffered ~9 GSIOC command to 
reset the NV-RAM and initialize to the 
default value. Run the 215 Setup Utility.

• Replace the main board.

16 X scale factor is invalid Contact your Gilson-authorized 
representative.
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17 Y scale factor is invalid Contact your Gilson-authorized 
representative.

18 Z scale factor is invalid Contact your Gilson-authorized 
representative.

20 X motor position error Turn power on/off to the liquid handler.

21 Y motor position error Turn power on/off to the liquid handler.

22 Z motor position error Turn power on/off to the liquid handler.

24 X target less than minimum X Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct 
the error in the program controlling the 
liquid handler.

25 X target more than maximum X Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct 
the error in the program controlling the 
liquid handler.

26 Y target less than minimum Y Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct 
the error in the program controlling the 
liquid handler.

27 Y target more than maximum Y Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct 
the error in the program controlling the 
liquid handler.

28 Z target less than minimum Z Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct 
the error in the program controlling the 
liquid handler.

29 Z target more than maximum Z Send the immediate Q command using the 
GSIOC Utility to read the travel range. Correct 
the error in the program controlling the 
liquid handler.

30 X encoder inactive Contact your Gilson-authorized 
representative.

Error Description Solution
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31 Y encoder inactive Contact your Gilson-authorized 
representative.

32 Z position sensor inactive Contact your Gilson-authorized 
representative.

33 Safety contact activated Release contact; restart.

34 X home phase is invalid Run the 215 Setup Utility to correct the 
problem.

35 Y home phase is invalid Run the 215 Setup Utility to correct the 
problem.

36 X and Y home phases are invalid Run the 215 Setup Utility to correct the 
problem.

40 Gilson m402 invalid valve position This is caused by the valve stem not turning 
properly or the encoder not registering 
properly. Try operating without a valve. If that 
fails, you will probably need a new module. If 
that works, check the valve assembly for 
smooth operation. If necessary, replace valve.

41 Gilson m402 valve missing Contact your Gilson-authorized 
representative.

42 Gilson m402 undefined valve command Try operating without a valve. If that fails, you 
will probably need a new module. If that 
works, check the valve assembly for smooth 
operation. If necessary, replace valve.

43 Gilson m402 valve communication error Try operating without a valve. If that fails, you 
will probably need a new module. If that 
works, check the valve assembly for smooth 
operation. If necessary, replace valve.

44 Gilson m402 valve unit busy Try operating without a valve. If that fails, you 
will probably need a new module. If that 
works, check the valve assembly for smooth 
operation. If necessary, replace valve.

Error Description Solution
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45 Gilson m402 syringe overload • Slow down flow rate indicated for aspirate 
and dispense commands in the program 
controlling the liquid handler.

• Use less viscous liquid.

• Use larger ID transfer tubing.

46 Gilson m402 syringe missing Try operating without a valve. If that fails, you 
will probably need a new module. If that 
works, check the valve assembly for smooth 
operation. If necessary, replace valve.

47 Gilson m402 undefined syringe 
command

Try operating without a valve. If that fails, you 
will probably need a new module. If that 
works, check the valve assembly for smooth 
operation. If necessary, replace valve.

48 Gilson m402 syringe communication 
error

Replace the syringe pump.

49 Gilson m402 syringe unit busy Replace the syringe pump

Error Description Solution
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Probe No Longer Finding Tube Center

• Probe may be bent. Straighten or replace the probe.

• Liquid handler may be misaligned. Perform the position alignment 
procedures, described on page 4-18.
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Electrical

Input Functions Not Operating

• Make sure connections into the terminal block connector are secure.

• Make sure the terminal block connector is secure in the input/output ports.

• Check connections for proper pin assignments.

• Be sure pins from external devices are assigned correctly.

• Check polarity of input. Inputs should be a contact closure. If not, it must be 
TTL level (logic 0 activates).

• Confirm that source supplying input to the liquid handler is working.

Output Functions Not Operating

• Make sure connections into the terminal block connector are secure.

• Make sure the terminal block connector is secure in the input/output ports.

• Check connections for proper pin assignments.

• Output from the liquid handler should be compatible with the device to 
which it is interfaced. Outputs are contact closures.

Unit Not Operational

• Make sure power is turned on.

• Check power cord connections.

• Try different outlet.

• Check fuse(s); replace if necessary.

• Check all liquid handler connections and make sure that the unit is plugged in.

Unit Blows Fuses

A blown fuse may indicate the existence of another problem in the instrument. If 
the replacement fuses blow, don't try others. Contact your Gilson-authorized 
representative. See Before Calling Us on page 5-11.
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Instrument Will Not Draw in Reagent

• Make certain all fittings are tight.

• Check valve fitting threads on the syringe pump. Replace if damaged.

No Fluid Being Dispensed

• Make sure the syringe is tight in the valve fitting.

• If tubing is kinked or blocked, replace defective tubing.

• Replace the syringe pump valve if damaged. Turn the power to the 
liquid handler off and then on to re-initialize.

Reagent Being Pulled Back Into Reservoir

• Replace the syringe pump valve if damaged. Turn the power to the 
liquid handler off and then on to re-initialize.

Air Gap Breaks Up

• When aspirating a liquid, if the air gap breaks up, check to see if the tubing is 
the correct size.

• Reduce speed of aspiration.

• Increase size of air gap.

• Clean or replace any dirty tubing.

Syringe Bubbles

• Make sure that all tubing fittings are tight and air-free.

• Make sure the syringe pump syringe is tightened onto the valve.

• Clean the syringe if dirty. Refer to page 4-3.

• If any of the syringe pump valve fittings are damaged, replace the valve.
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Fluid Leak

• Replace any worn piston seals on the syringe piston. Instructions are supplied 
with replacement seals.

• Clean syringe pump valve. Refer to page 4-7.

• Allow reagents to warm to room temperature before using.

Incorrect Aspirating and Dispensing

• Check for leaks on all fittings and tubes leading to the probe.

• Tighten or replace fittings on inlet and transfer tubing as needed.

• Replace the syringe pump valve if damaged. Turn the power to the 
liquid handler off and then on to re-initialize.

Syringe Stalls

• If the syringe on the syringe pump stalls, there may be a blockage in the 
tubing or valve. Inspect all tubing and the valve. 

• If the syringe stalls due to an accelerated aspirate or dispense rate, reduce the 
rate in the program controlling the liquid handler.

Poor Accuracy

• Worn piston seals and tubing can cause the liquid handler to perform with 
poor volumetric accuracy and precision. If the aspirate and dispense speeds 
are too fast, slow down the speeds to adapt to the tubing and probe type.
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Liquid Level Detector Not Detecting Liquid Level

• Ensure that the level sensing cable is plugged in.

• Check sensitivity setting in the 215 Setup Utility.

• Check if liquid is detectable. Liquid level detection works only if there is 
electrical conductivity in your liquid. Liquid level detecting will not work with 
most non-polar liquids. For intermediate polarity liquids and polar liquids, 
check the sensitivity setting in the 215 Setup Utility.
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Repair and Return Policies

Before Calling Us

Gilson-authorized representatives will be able to serve you more efficiently if you 
have the following information:

• the serial number and model number of the instruments involved. The serial 
number is visible on the inside right support of the liquid handler. 

• the installation procedure you used

• list of concise symptoms

• list of operating procedures and conditions you were using when the problem 
arose

• list of other devices connected to the liquid handler and a description of those 
connections

• list of other electrical connections in the room

Warranty Repair

Units covered under warranty will be repaired and returned to you at no charge. 
If you have any questions about applicability, please contact your local 
distributor.

Non-Warranty Repair

For out-of-warranty repairs, contact your local distributor. A Customer Service 
representative will discuss service options with you and can assist in making 
arrangements to return the equipment, if necessary.

Rebuilt Exchange

For some units, rebuilt exchange components are available. Contact your local 
distributor for details.
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Contact your local distributor’s Customer Service Department to obtain 
authorization before returning any Gilson equipment. To return a piece of 
equipment:

• Carefully pack the unit to prevent damage in transit. Check with your 
distributor regarding proper method of shipment. No responsibility is 
assumed by Gilson or your distributor for damage caused by improperly 
packaged instruments. Indicate the authorization on the carton and on the 
packing slip.

• Always insure for the replacement value of the unit.

• Include a description of symptoms, your name, address, phone number, and 
purchase order to cover repair costs, return and shipping charges, if your 
institution requires it. 

Unit End-of-Life

When a unit reaches the end of its useful life, refer to www.gilson.com 
for directions and information on the end-of-life policy. This is in 
accordance with the European Union Directive 2002/96/EC on Waste 
Electrical and Electronic Equipment (WEEE).
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Syringes

Part Number Description

2510121 215 Liquid Handler

2510191 215 Liquid Handler without Pump

Part Number Description

25025341 100 μL syringe

25025342 250 μL syringe

25025347 500 μL syringe

25025343 1 mL syringe

25025344 5 mL syringe

25025345 10 mL syringe

25025346 25 mL syringe
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Probes for 125 mm Z-Arm

Part Number Description

2507234

Septum-piercing probe; side-entry, capacitive level-sensing, stainless steel, strain-relief 
design. Dimensions: 274 x 1.8 x 0.8 mm ID (tip dimensions: 12 x 1.3 mm OD, entry hole 
center is 3.5 mm from tip). Compatible with 819 Injection Module; requires injection 
port (part number 25051015). Requires probe holder/guide kit (part number 253640).

2507235

Septum-piercing probe; side-entry, vented, capacitive level-sensing, stainless steel, 
strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID (tip dimensions: 12 x 1.3 x mm OD, 
entry hole center is 3.5 mm from tip). Compatible with the 819 Injection Module; 
requires injection port (part number 25051015). 
Requires probe/holder guide kit (part number 253640).

2507236

Septum-piercing, short pencil-point probe; vented at 14 mm, side-entry, vented at 
72 mm, capacitive level sensing, stainless steel. Dimensions: 272 x 1.8 x 0.8 mm ID. 
Compatible with the 819 Injection Module; requires injection port 
(part number 25051015). Requires probe holder/guide kit (part number 253640).

2507237

Septum-piercing, pencil-point probe; vented at 72 mm, side-entry, capacitive level 
sensing, stainless steel. Dimensions: 273 x 1.8 x 0.8 mm ID. Compatible with 819 Injection 
Module; requires injection port (part number 25051015). 
Requires probe holder/guide kit (part number 253640).

2507244
Septum-piercing probe; deflected tip, capacitive level-sensing, stainless steel, 
strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID (tip dimensions: 12 x 1.3 mm OD, 
bevel cut entry hole). Requires probe holder/guide kit (part number 253640).

2507245
Septum-piercing probe; deflected tip, vented, capacitive level-sensing, stainless steel, 
strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID (tip dimensions: 12 x 1.3 mm OD, 
bevel cut entry hole).Requires probe holder/guide kit (part number 253640).

2507242

Septum-piercing probe; deflected tip, capacitive level-sensing, stainless steel with 
Teflon-coated liquid path, strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID (tip 
dimensions: 12 x 1.3 mm OD, bevel cut entry hole). 
Requires probe holder/guide kit (part number 253640).

2507243

Septum-piercing probe; deflected tip, vented, capacitive level-sensing, stainless steel 
with Teflon-coated liquid path, strain-relief design. Dimensions: 274 x 1.8 x 0.8 mm ID 
(tip dimensions 12 x 1.3 mm OD, bevel cut entry hole). 
Requires probe holder/guide kit (part number 253640).
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27067361
Non septum-piercing probe; bevel tip, capacitive level-sensing, stainless steel. 
Dimensions: 220.5 x 1.5 x 1.1 mm ID. 
Requires probe holder/guide kit (part number 253641). 

2507414

Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel. 
Dimensions: 220 x 1.3 x 0.8 mm ID (tip dimensions: 1.5 x 0.9 x 0.45 mm ID). Compatible 
with 819 Injection Module; requires injection port (part number 25051015). 
Requires probe holder/guide kit (part number 253642).

27067373

Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel. 
Dimensions: 221 x 1.5 x 1.1 mm ID (tip dimensions: 2 x 1.1 x 0.4 mm ID). Compatible with 
819 Injection Module; requires injection port (part number 2954640). 
Requires probe holder/guide kit (part number 253641).

27067374

Non septum-piercing probe; constricted bevel tip, capacitive level-sensing, stainless 
steel. Dimensions: 221 x 1.5 x 1.1 mm ID (tip dimensions: 2 x 1.1 x 0.4 mm ID). Compatible 
with 819 Injection Module; requires injection port (part number 2954640). 
Requires probe holder/guide kit (part number 253641).

2507252

Micro septum-piercing probe; constricted 45° bevel tip, capacitive level-sensing, 
stainless steel. Dimensions: 220 x 1.5 x 1.1 mm ID (tip dimensions: 10 x 0.7 x 0.4 mm ID). 
Compatible with 819 Injection Module; requires injection port (part number 2954640). 
Requires probe holder/guide kit (part number 253641). 

2507256
Beveled-tip probe, stainless steel, grooved septum-piercing; 221 x 1.5 x 0.4 mm ID. 
Compatible with 819 Injection Module; requires injection port (part number 2954640). 
Requires probe holder/guide kit (part number 253641).

27067383 PROBE, SP, 221 x 1.5 x 0.4 mm, BEVEL, GROOVE, 28.73 μL VOLUME

27067375
Non-septum-piercing probe: beveled-tip, Teflon-coated stainless steel. Dimensions: 
221 x 1.5 x 1.1 mm ID. Requires probe holder/guide kit (part number 253641).

27067382
Beveled-tip probe, stainless steel, grooved septum-piercing. 
Dimensions: 221 x 2.0 x 0.8 mm ID (tip dimensions: 2.1 x 1.5 x 0.8 mm ID, 100 μL volume).

251646
Inert gas probe assembly (for maintaining an inert atmosphere inside sealed vessel), 
beveled tip, stainless steel, strain-relief design. 
Dimensions: 274 x 1.8 x 0.8 mm ID. Includes probe holder/guide kit.

Part Number Description
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Part Number Description

2507214
Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel. 
Dimensions: 269 x 1.8 x 1.4 mm ID (tip dimensions: 1.5 x 1.2 x 0.8 mm ID). 
Requires probe holder/guide kit (part number 253640).

2507215

Non septum-piercing probe; constricted tip, capacitive level-sensing, stainless steel. 
Dimensions: 269 x 1.3 x 0.8 mm ID (tip dimensions: 1.5 x 0.9 x 0.45 mm ID). Compatible 
with 819 Injection Module; requires injection port (part number 25051015). 
Requires probe holder/guide kit (part number 253642).

2507216

Non septum-piercing probe, bevel tip, capacitive level sensing, stainless steel. 
Dimensions: 269 x 1.5 x 1.1 mm ID (tip dimensions: 1.6 x 1.2x 0.8). Compatible with 
819 Injection Module; requires injection port (part number 2954674). 
Requires probe holder/guide kit (part number 253641). 

2507253

Micro septum-piercing probe; constricted 45° bevel tip, capacitive level sensing, 
stainless steel. Dimensions: 269 x 1.5 x 1.1 mm ID (tip dimensions: 10 x 0.7 x 0.4 mm ID). 
Compatible with 819 Injection Module; requires injection port (part number 270728). 
Requires probe holder/guide kit (part number 253641). 

2507254
Non septum-piercing probe; flat tip, capacitive level-sensing, stainless steel. 
Dimensions: 269 x 1.8 x 1.4 mm ID. 
Requires probe holder/guide kit (part number 253640)

2507255

Non septum-piercing probe, bevel tip, capacitive level sensing, stainless steel. 
Dimensions: 269 x 1.5 x 0.4 mm ID. Compatible with 819 Injection Module; requires 
injection port (part number 2954640). 
Requires probe holder/guide kit (part number 253641). 

2507555
Inert non septum-piercing probe; Teflon-covered stainless steel. Dimensions: 269 x 2.7 
x 0.8 mm ID (tip dimensions: 5 x 1.5 mm OD). 
Requires probe holder/guide kit (part number 253645).

25075551
 Non septum-piercing probe; straight tip. Dimensions: 256.6 x 2.7 x 0.8 mm ID. 
Requires probe holder/guide kit (part number 253645)

25073645

Beveled tip, capacitive level-sensing, stainless steel. Dimensions: 269 x 1.3 x 0.8 mm ID. 
Beveled tip pierces thin septa (use part number 26017050 for thick septa). Compatible 
with 819 Injection Module; requires injection port (part number 25051015). 
Requires probe holder/guide kit (part number 253642).

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Gilson 215 Liquid Handler User’s Guide A-5

Appendix A
R

ep
lacem

en
t Parts an

d
 A

ccesso
ries

Probe Holder/Guide Kits

Transfer Tubing

Part Number Description

253640
Probe holder/guide kit; includes probe holder and guide for 1.8 mm outer diameter 
probes.

253641
Probe holder/guide kit; includes probe holder and guide for 1.5 mm outer diameter 
probes.

253642
Probe holder/guide kit; includes probe holder and guide for 1.3 mm outer diameter 
probes.

253643
Probe holder/guide kit; includes probe holder and guide for 2.0 mm outer diameter 
probes.

253645
Probe holder/guide kit; includes probe holder and guide for 2.7 mm outer diameter 
probes.

Part Number Description

499421202 1.5 mL FEP tubing; 0.8 mm ID x 10 feet

499424012 1 mL coiled FEP tubing, 0.8 mm ID.

499474032 3 mL coiled FEP Tubing, 0.8 mm ID, for 215

499474052 5 mL coiled FEP transfer tubing; 1.5 mm ID

499474102 10 mL coiled FEP tubing; 1.5 mm ID x 24 feet

499474252 25 mL coiled FEP tubing; 1.5 mm ID x 50 feet
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Rinse Station Inserts

Waste Bottle and Accessories

Part Number Description

250782
Complete rinse station; includes rinse station base and body, Tygon tubing, and waste 
bottle with lid and quick-connect fitting. Order rinse station insert separately.

Part Number Description

25245532
Shallow-pocket rinse station insert, closed-bottom, for applications where the probe is 
only immersed in a few millimeters of the sample; for use with 125 mm Z-arm.

25245533
Deep-pocket rinse station insert, closed-bottom, allows for deeper insertion of the 
probe into the rinse well, resulting in a greater area of the outside of the probe to be 
rinsed; for use with 125 mm Z-arm.

25245531
Flow-through rinse station insert, open-bottom, for flowing rinse applications; for use 
with 125 mm Z-arm.

25245542
Shallow-pocket rinse station insert, closed-bottom, for applications where the probe is 
only immersed in a few millimeters of the sample; for use with 175 mm Z-arm.

25245543
Deep-pocket rinse station insert, closed-bottom, allows for deeper insertion of the 
probe into the rinse well, resulting in a greater area of the outside of the probe to be 
rinsed; for use with 175 mm Z-arm.

25245541
Flow-through rinse station insert, open-bottom, for flowing rinse applications; for use 
with 175 mm Z-arm.

Part Number Description

23077333 Y-connector to connect two rinse stations to one waste bottle

23077310 Organon waste bottle (2 liter) with lid and quick-connect fitting

470343706
Tygon tubing (5/16” ID x 7/16” OD) for connection between rinse station and 
waste bottle; per foot

23077332 Quick-connect fitting to connect Tygon tubing to Organon waste bottle

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Gilson 215 Liquid Handler User’s Guide A-7

Appendix A
R

ep
lacem

en
t Parts an

d
 A

ccesso
ries

Racks
For part numbers for available racks, refer to Appendix B, Racks. To create your own 
code 200-style rack, order the blank rack kit (part number 254461) and rivet gun 
(part number 4391002).

Rack Accessories

Part Number Description

2504621 Adapter plate for installing Code 20- or 30-series rack on locator plate

2504632 Adapter rack for Code 0, 8, or 9 rack

2504627 Locator tray for installing up to seven Code 20- or 30-series racks on the locator plate.

2704429
Thermostating cuvette. Holds one Code 30, 31, 32, 33, or 34 rack. Requires circulating 
water bath for temperature control. 

2759502
832 Temperature Regulator for electrically controlled sample heating or cooling; 
100/120V, 50/60 Hz. Controls up to two 832 Thermostating Cuvettes. Order 832 
Thermostating Cuvettes and thermostated racks separately.

2759550
832 Thermostating Cuvette. Holds one Code 30, 31, 32, 33, or 34 rack. Requires 832 
Temperature Regulator.

27044307 Rack cover for Code 30 rack; stainless steel. Holds vial in rack wells when cooling samples.

27044317
Rack cover for Code 31 rack; stainless steel. Holds vials in rack wells when cooling 
samples.

27044347
Rack cover for Code 34 rack; stainless steel. Holds vials in rack wells when cooling 
samples.
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Armlock

Z-Height Adjustment Tools

Part Number Description

6730254007 2.5A, T-2.5 Slo-Blo fuse

25064040 Level-sensing cable

36083121 Serial cable, IBM PS/2-type, 25 to 25 pin

36083122 Serial cable, IBM AT-type, 9-pin female to 25-pin male

36083123 Serial cable adapter, 9-pin female to 25-pin male

36078143 Shielded GSIOC cable, 30”

638308512 Terminal block connector, 8-pin

638310512 Terminal block connector, 10-pin

709910206 2-conductor interconnect wire, 6’, for making contact connections

Part Number Description

2509211 Armlock with hex screw

4311403 9/64” ball driver (hex wrench for armlock)

Part number Description

25051094

125 mm Z-height adjustment tool

Use this tool to adjust a 125 mm Z-arm on a 215 Liquid Handler for use with the 
819 Injection Module; no Gilson 818 AutoMix is installed on the 215 Liquid Handler.

25051095

175 mm Z-height adjustment tool 

Use this tool to adjust a 175 mm Z-arm on a 215 Liquid Handler for use with the 
819 Injection Module. Or, use this tool to adjust a 125 mm Z-arm when a Gilson 
818 AutoMix is installed along with the injection module on the 215 Liquid Handler.

95260002

270 mm Z-height adjustment tool 

Use this tool to adjust the Z-arm on a 215 SW Liquid Handler for use with the 
819 Injection Module. 
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The 215 Liquid Handler can be configured with a variety of rack types and sizes. The following pages 
describe the racks that can be purchased for use on the liquid handler. Refer to Chapter 2, Installation 
for rack installation procedures.
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LOCATOR PLATE, 
215 STANDARD 

(part number 25045511)

LOCATOR PLATE, 
6 POSITION, 215

(part number 25045513)

TRAY FOR 7 CODE 20- OR 
30-SERIES RACKS 

(part number 2504627)*

Code 0, 8, 9

Up to five racks

Each rack requires an adapter 
plate (part number 2504621) and 
an adapter rack (part number 
2504632)
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Up to three racks when one 
AutoMix is installed or up to two 
racks when two AutoMixes are 
installed

Each rack requires an RH1 rack 
heightener (part number 
25045514), adapter plate 
(part number 2504621), and an 
adapter rack (part number 
2504632)
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Up to seven racks

Each rack requires an adapter 
rack (part number 2504632)
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Code 20-series

Up to five racks

Each rack requires an adapter 
plate (part number 2504621)

Up to three racks when one 
AutoMix is installed or up to two 
racks when two AutoMixes are 
installed

Each rack requires an RH1 rack 
heightener (part number 
25045514) and adapter plate 
(part number 2504621)

Up to seven racks

Code 30-series

Code 200-series

Up to five racks

Up to three racks when one 
AutoMix is installed or up to two 
racks when two AutoMixes are 
installed

Each rack requires an RH1 rack 
heightener (part number 
25045514) 

N/A

Code 242 Peltier

Code 300-series

Code 600-series

Code 85X Peltier

Code 502

Up to two racks

One position left available for the 
addition of a Code 0, 8, or 9 rack with 
adapter plate and rack, or 
Code 20-series or 30-series rack with 
adapter plate, or Code 200-series, or 
300-series rack

N/A
Code 505, 505H

One rack

One position left available for the 
addition of a Code 0, 8, or 9 rack with 
adapter plate and rack, or 
Code 20-series or 30-series rack with 
adapter plate, or Code 200-series, or 
300-series rack

Code 542

Code 517 One rack

818 AutoMix One AutoMix Up to two AutoMixes

* Install TRAY FOR 7 CODE 20- OR 30-SERIES RACKS (part number 2504627) on 
LOCATOR PLATE, 215 STANDARD (part number 25045511)
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Code 0 rack
For 80 vessels

Material: polypropylene

Vessels and maximum capacity: 12 x 32 mm tubes (2 mL)

Part number: 270430

Required accessories: adapter plate (part number 2504621) 
and adapter rack (part number 2504632)

Code 8 rack
For 120 vials

Material: polypropylene

Vessels and maximum capacity: 6 x 32 mm tubes (0.3 mL)

Part number: 270438

Required accessories: adapter plate (part number 2504621) 
and adapter rack (part number 2504632)

Code 9 rack
For 120 vials

Material: polypropylene

Vessels and maximum capacity: 7 x 40 mm vials (0.7 mL)

Part number: 270439

Required accessories: adapter plate (part number 2504621) 
and adapter rack (part number 2504632)
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For 108 vessels

Material: polypropylene

Vessels and maximum capacity: 10 x 100 mm tubes (4.5 mL)

Part number: 150425

Required accessories: adapter plate (part number 2504621)

Code 21 rack
For 60 vessels

Material: polypropylene

Vessels and maximum capacity: 13 x 100 mm tubes (9 mL)

Part number: 150422

Required accessories: adapter plate (part number 2504621)

Code 22 rack
For 44 tubes

Material: polypropylene

Vessels and maximum capacity: 18 x 100 mm tubes (25 mL)

18 x 150 mm tubes (32 mL)

Part number: 150424

Required accessories: adapter plate (part number 2504621)
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Code 22U rack
For 44 vessels

Material: polypropylene

Vessels and maximum capacity: from 10 x 100 mm tubes 
(3.5 mL) to 18 x 180 mm 
tubes (32 mL)

Part number: 150498

Required accessories: adapter plate (part number 2504621)

Note: Each of the reception cavities contains four 
positioning and retaining clips.

Code 23 rack
For 44 mini-scintillation vials

Material: polypropylene

Vessels and maximum capacity: 17 x 55 mm vials (6.8 mL)

17 x 65 mm vials (8 mL)

Part number: 150426

Required accessories: adapter plate (part number 2504621)
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ks Code 23W rack
For 44 WISP-style vials

Material: polypropylene and stainless steel

Vessels and maximum capacity: 15 x 45 mm vials (4 mL)

Part number: 270433

Required accessories: adapter plate (part number 2504621)

Code 24 rack
For 14 scintillation vials

Material: polypropylene

Vessels and maximum capacity: 28 x 57 mm vials (20 mL)

28 x 60 mm vials (20 mL)

Part number: 150427

Required accessories: adapter plate (part number 2504621)

Code 28 rack
For 108 vessels

Material: polypropylene

Vessels and maximum capacity: 10 x 65 mm tubes (3 mL)

10 x 75 mm tubes (4 mL)

Part number: 150420

Required accessories: adapter plate (part number 2504621)
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Code 29 rack
For 60 vessels

Material: polypropylene

Vessels and maximum capacity: 12 x 75 mm tubes (5 mL)

13 x 75 mm tubes (6 mL)

Part number: 150429

Required accessories: adapter plate (part number 2504621)

Code 30 rack
For 60 vessels

Material: aluminum

Vessels and maximum capacity: 12 x 32 mm vials (2 mL)

Part number: 2704430

Required accessories: adapter plate (part number 2504621) 
and thermostating cuvette (part number 2704429) or 
thermostating cuvette (part number 2759550) and 832 
Temperature Regulator (part number 2759502)
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ks Code 31 rack
Thermostated rack for 108 vessels

Material: aluminum

Vessels and maximum capacity: 7 x 40 mm vials (0.7 mL)

Part number: 2704431

Required accessories: adapter plate (part number 2504621) 
and thermostating cuvette (part number 2704429) or 
thermostating cuvette (part number 2759550) and 832 
Temperature Regulator (part number 2759502)

Code 32 rack
Thermostated rack for 60 tubes

Material: aluminum

Vessels and maximum capacity: 13 x 65 mm tubes (6 mL)

Part number: 2704432

Required accessories: adapter plate (part number 2504621) 
and thermostating cuvette (part number 2704429) or 
thermostating cuvette (part number 2759550) and 832 
Temperature Regulator (part number 2759502)
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Code 33 rack
Thermostated rack for 14 scintillation vials

Material: aluminum

Vessels and maximum capacity: 28 x 57 mm vials (20 mL)

Part number: 2704433

Required accessories: adapter plate (part number 2504621) 
and thermostating cuvette (part number 2704429) or 
thermostating cuvette (part number 2759550) and 832 
Temperature Regulator (part number 2759502)

Code 34 rack
Thermostated rack for 36 WISP-style vials

Material: aluminum

Vessels and maximum capacity: 15 x 45 mm vials (4 mL)

Part number: 2704434

Code 200 rack

For 96 VACUTAINER® tubes

Material: aluminum

Vessels and maximum capacity: 13 x 100 mm tubes (9 mL)

Part number: 2504600
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ks Code 201 rack
For two microplates, two microcentrifuge tubes, and two 
13 x 100 mm tubes

Material: aluminum

Vessels and maximum capacity: 96 well microplates 
microcentrifuge tubes 
(1.5 mL)

13 x 100 mm tubes (9 mL)

Part number: 2504601

Code 201H rack
For two 96-well microplates with hold-down covers, two vials, 
and two tubes

Material: aluminum

Vessels and maximum capacity: 13 x 100 mm tubes (9 mL)

Part number: 2504601H

Code 202 rack
For 96 VACUTAINER tubes

Material: aluminum

Vessels and maximum capacity: 10.25 x 45 mm (1.5 mL)

Part number: 2504602
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Code 203 rack
For 96 tubes

Material: aluminum

Vessels and maximum capacity: 10 x 64 mm tubes (3 mL)

10 x 75 mm tubes(3.5 mL)

Part number: 2504603

Code 204 rack
For 27 scintillation vials

Material: aluminum

Vessels and maximum capacity: 28 x 57 mm vials (20 mL)

Part number: 2504604

Code 204F rack
Rack with funnel drain assembly

For 24 scintillation vials

Material: aluminum

Vessels and maximum capacity: 28 x 57 mm vials (20 mL)

Part number: 2504604F

Requires 215 Prep FC Valve, Low Mount (part number 251774) 

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Appendix B

B-12 Gilson 215 Liquid Handler User’s Guide

R
ac

ks Code 205 rack
For two deep-well microplates, two microcentrifuge tubes, 
and two 13 x 100 mm tubes

Material: aluminum

Vessels and maximum capacity: 96 deep-well microplates 
microcentrifuge tubes 
(1.5 mL)

13 x 100 mm tubes (9 mL)

Part number: 2504605

Code 205H rack
For two deep-well microplates with hold-down covers

Material: aluminum

Vessels and maximum capacity: 13 x 100 mm tubes (9 mL)

Part number: 2504605H

Code 206 rack
For 96 VACUTAINER tubes

Material: aluminum

Vessels and maximum capacity: 13 x 75 mm tubes (4 mL)

Part number: 2504606
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Code 207 rack
For 75 VACUTAINER tubes

Material: aluminum

Vessels and maximum capacity: 16 x 100 mm tubes (12 mL)

Part number: 2504607

Code 208 rack
For 70 tubes

Material: aluminum

Vessels and maximum capacity: 18 x 100 mm tubes (15 mL)

18 x 150 mm tubes (25 mL)

Part number: 2504608

Code 209 rack
For 96 vials

Material: aluminum

Vessels and maximum capacity: 12 x 32 mm vials (2 mL)

Part number: 2504609
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For 75 VACUTAINER tubes

Material: aluminum

Vessels and maximum capacity: 16 x 75 mm tubes (10 mL)

Part number: 2504610

Code 211 rack
For 9 round screw-cap bottles

Material: aluminum

Vessels and maximum capacity: 48 x 113 mm bottles (125 mL)

Part number: 2504611

Code 211F rack
Rack with funnel drain assembly

For 8 round screw-cap bottles

Material: aluminum

Vessels and maximum capacity: 48 x 113 mm bottles (125 mL)

Part number: 2504611F

Requires 215 Prep FC Valve, Low Mount (part number 251774) 
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Code 211H rack
For 9 round screw-cap bottles with hold-down cover

Material: aluminum

Vessels and maximum capacity: 48 x 113 mm bottles 
(125 mL)

Part number: 2504611H

Code 212 rack
For 96 VacuTainer tubes

Material: aluminum

Vessels and maximum capacity: 48 13 x 100 mm tubes (9 mL) 

48 13 x 75 mm tubes(4 mL) 

Part number: 2504612

Note: Place the shorter tubes into the notched tube 
locations.
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For 74 VacuTainer tubes

Material: aluminum

Vessels and maximum capacity: 16 x 100 mm 37 tubes (12 
mL) 

16 x 75 mm 37 tubes 
(10 mL) 

Part number: 2504613

Note: Place the shorter tubes into the notched tube 
locations.

Code 214 rack
For 96 VacuTainer tubes

Material: aluminum

Vessels and maximum capacity: 10.25 x 47 mm 48 tubes 
(2.5 mL) 

10.25 x 64 mm 48 tubes 
(3 mL)

Part number: 2504614

Note: Place the shorter tubes into the notched tube 
locations.
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Code 216 rack
For 60 WISP vials

Material: aluminum

Vessels and maximum capacity: 15 x 45 mm vials (4 mL) 

Part number: 2504616

Code 217 rack
For 96 tubes

Material: aluminum

Vessels and maximum capacity: 10 x 75 mm tubes (4 mL) 

Part number: 2504617

Code 218 rack
For 96 standard or deep-well microplate and tubes

Material: aluminum

Vessels and maximum capacity: 10 x 75 mm (4 mL) 

Part number: 2504618
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ks Code 219 rack
For 27 vials

Material: aluminum

Vessels and maximum capacity: 30 x 95 mm vials (4 mL) 

Part number: 2504619

Code 220 rack
For 70 vials 

Material: aluminum

Vessels and maximum capacity: 17 x 55 mm vials (6.8 mL)

17 x 65 mm vials (8 mL)

Part number: 2504620

Code 222 rack
For 27 conical bottom tubes

Material: aluminum

Vessels and maximum capacity: 30 x 115 mm tubes (50 mL)

Part number: 2504622
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Code 222F rack
Rack with funnel drain assembly

For 24 conical bottom tubes 

Material: aluminum

Vessels and maximum capacity: 30 x 115 mm tubes (50 mL) 

Part number: 2504622F

Requires 215 Prep FC Valve, Low Mount (part number 251774)

Code 223 rack
For 96 tubes with screw caps

Material: aluminum

Vessels and maximum capacity: 16 x 100 mm tubes (10 mL)

Part number: 2504623

Code 224 rack
For 192 vials

Material: aluminum

Vessels and maximum capacity: 8.5 x 41 mm vials

Part number: 2504624
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ks Code 225 rack
For 45 vials

Material: aluminum

Vessels and maximum capacity: 25 x 150 mm vial (45 mL)

Part number: 2504625

Code 226 rack
For 96 WISP-style vials

Material: aluminum

Vessels and maximum capacity: 15 x 45 mm vials (4 mL) 

Part number: 2504626

Code 228 rack
For four reagent bottles

Material: aluminum

Vessels and maximum capacity: 4 (500 or 700 mL) 

Part number: 2504628
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Code 237 rack
For two 384- or 96-well, shallow, flat-bottomed microplates

Material: aluminum

Vessels and maximum capacity: 384-well microplates

Part Number: 2504637

Code 300 rack
For 96 deep-well microplates and one cartridge

Material: aluminum

Part number: 2504300

Code 301 rack
For 96 shallow-well microplates and one cartridge

Material: aluminum

Part number: 2504301

Code 302 rack
For 48 cartridges and 48 vials

Material: aluminum

Vessels and maximum capacity: 12 x 32mm vials (2 mL) 

Part number: 2504302
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ks Code 303 rack
For 48 cartridges and 48 vials

Material: aluminum

Vessels and maximum capacity: 12 x 32 mm vial (2 mL) 

Part number: 2504303

Code 304 rack
For 48 cartridges and 48 tubes

Material: aluminum

Vessels and maximum capacity: 12 x 75 mm tube (5 mL) 

Part number: 2504304

Code 305 rack
For 32 cartridges and 32 vials

Material: aluminum

Vessels and maximum capacity: 15 x 45 mm vial (4 mL) 

Part number: 2504305
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Code 306 rack
For 20 cartridges and 20 tubes

Material: aluminum

Vessels and maximum capacity: 12 x 75 mm tube (5 mL) 

Part number: 2504306

Code 307 rack
For 20 cartridges and 20 vials

Material: aluminum

Vessels and maximum capacity: 15 x 45 mm WISP vial (4 mL) 

Part number: 2504307

Code 502 rack
For 100 vials

Material: aluminum

Vessels and maximum capacity: 12 x 32mm (2 mL) 

Part number: 2504652
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ks Code 505 rack
For 10 standard or deep-well microplates

Material: aluminum

Part number: 2504651

Code 505H rack
For 10 standard or deep-well microplates with hold-down 
covers

Material: aluminum

Part number: 2504651H

Code 517 rack
For 17 microplates with hold-down cover

Material: aluminum

Part number: 2504653
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Code 641 rack
For 24 vials

Material: aluminum

Vessels and maximum capacity: 28 x 100 mm vials (45 mL) 

Part number: 2504641

Code 642 rack
For 48 tubes

Material: aluminum

Vessels and maximum capacity: 16 x 78 mm tubes

Part number: 2504642

Code 643 rack
For 2 solid phase and solution phase reaction block

Material: aluminum

Part number: 2504643

Code 644 rack
For 2 solid phase and solution phase reaction blocks

Material: aluminum

Part number: 2504644
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ks Code 645 rack
For 2 solid phase and solution phase multitemperature 
reaction blocks w/gas manifold

Material: aluminum

Part number: 2504645

Code 646 rack
For 2 solid phase and solution phase multitemperature 
reaction block

Material: aluminum

Part number: 2504646

Code 647 rack
For 4 Robbins Scientific Flexchem™ solid phase synthesis 
reaction block

Material: aluminum

Part number: 2504647
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Peltier Racks

Code 242 Peltier rack
For 2 shallow, flat-bottom, 96-well microplates

Material: aluminum

Part number: 25146331

Note: Order Peltier Controller (part number 2515331) and 
junction box (part number 2505332) separately.

Code 542 Peltier rack
For 10 shallow, flat-bottom, 96-well microplates

Material: aluminum

Part number: 2514542

Note: Order Peltier Controller (part number 2515331) 
separately.

Code 852 Peltier rack
For two Becton Dickinson Falcon 96-well, shallow-well assay 
plates. U-bottom style

Material: aluminum

Part number: 2514852

Note: Order Programmable Peltier Controller 
(part number 2515850) separately.
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For 96 12x32 mm 2 mL, flat-bottom vials

Material: aluminum

Part number: 2514853

Note: Order Programmable Peltier Controller 
(part number 2515850) separately.

Code 854 Peltier rack
For two Ritter or Beckman 96-well, deep-well microplates

Material: aluminum

Part number: 2514854

Note: Order Programmable Peltier Controller 
(part number 2515850) separately.
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The GSIOC Configuration Editor enables you to modify COM (serial communications) port and baud rate 
information. Or, you can use this editor if incorrect information appears in the GSIOC Utility window.

1 Locate the GSIOC Configuration Editor (GSCONFIG.EXE) using Windows Explorer or the shortcut at 
Start—Programs—Gilson Applications—Utilities—GSIOC Configuration Editor. During 
installation, this editor was stored to C:\GILSON\UTIL unless the installation path was changed.

2 Start the editor. The GSIOC Configuration Editor window appears.

3 In the Port box, indicate the computer’s serial communications port (COM) port to which the Gilson 
interface instrument (such as the liquid handler or 506C System Interface) is connected.

4 Click 19200 or 9600 to select the baud. The baud is the rate of data transmission between the 
computer and the Gilson instrument.

5 Click OK to save the changes. A message box appears indicating that the computer must be restarted 
before any changes become effective.
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GSIOC Utility D

The GSIOC Utility allows you to issue commands to Gilson GSIOC instruments. Your Gilson-authorized 
representative may ask you to use this utility to verify that an instrument is connected correctly to the 
computer. For communication to occur, the Gilson instrument must be connected via an RS-232 
connection to the computer or connected via a GSIOC connection to a Gilson interface instrument that 
is connected to the computer.
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1 Locate the GSIOC Utility (GSUTIL32.EXE) using Windows Explorer or the 
shortcut at Start > (All) Programs > Gilson Applications > Utilities > 
GSIOC Utility. During installation, this utility was stored to C:\GILSON\UTIL 
unless the installation path was changed.

2 Start the utility. The GSIOC Utility window appears.

Review the Port and Baud Information

In the GSIOC Utility window, review the COM port and baud information. If any 
information is incorrect or missing, close the GSIOC Utility and use the GSIOC 
Configuration Editor to update the information. Refer to Appendix C, GSIOC 
Configuration Editor.

Listing GSIOC Instruments

Using the GSIOC Utility, you can determine the instruments currently connected 
to the computer.

In the Mode menu, select Scan!

The Unit ID list box displays the unit IDs and the version of the connected 
instruments. If any connected instruments are missing from the list, ensure that 
the proper RS-232 or GSIOC connection exists between the computer and the 
instruments, and that the instruments do not have duplicate unit ID numbers.
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Basic Mode

In the Basic mode, immediate and buffered GSIOC commands can be sent to 
specific Gilson instruments.

Review the Port, IRQ, and Baud information in this window. If any information is 
incorrect or missing, close the GSIOC Utility and use the GSIOC Configuration 
Editor to update the information.

There are two drop-down menus in the Basic mode of the Gilson GSIOC Utility: 
Mode Menu and Help Menu.

Basic Mode Buttons and Features

Immediate Button

Sends an immediate command to the Unit ID selected.

Immediate commands request status information from an instrument. These 
commands are executed immediately, temporarily interrupting any command in 
progress. 

You can find a list of valid immediate commands for each instrument in its 
commands list or user’s guide.

Buffered Button

Sends a buffered command to the Unit ID selected.

Buffered commands send instructions to an instrument. These commands are 
executed one at a time. 

You can find a list of valid buffered commands for each instrument in its 
commands list or user’s guide.

Command Field

Where the command to be sent is specified. For more information on sending 
commands, see Send an Immediate Command on page D-16 or Send a 
Buffered Command on page D-16.
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Returns a response to an immediate or buffered command.

The response to a successfully completed buffered command is “ok”.

Refer to the user’s guide for the Gilson instrument for a description of the valid 
response to immediate commands.

The response to an unsuccessfully completed immediate or buffered command 
is “#error”.

Basic Mode Menus

Mode Menu

There are three options in the Mode menu: Scan!, Advanced, and Ghost.

Scan!

The Scan! option on the Mode menu allows you to 
scan for GSIOC instruments. After a scan, the Unit ID 
list box displays the unit IDs and the version of the 
connected instruments. If any connected 
instruments are missing from the list, ensure that the proper RS-232 or GSIOC 
connection exists between the computer and the instruments, and that the 
instruments do not have duplicate Unit ID numbers.

Advanced

The advanced option in the Mode menu allows you to switch 
between the Basic and Advanced modes. A check mark 
means that the GSIOC Utility is in Advanced mode.

Ghost

The Ghost option in the Mode menu makes the GSIOC Utility window 
transparent (and always on top). This allows you to view another window behind 
the Utility. The Utility will remain fully functional in the Ghost mode.
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Help Menu

Help Topics

When selected, the Help window for the Gilson GSIOC Utility appears.

About

When selected, the About window appears.

This window displays the version of the Gilson GSIOC Utility, the GSIOC32.DLL, 
and the GSIOC Server or Driver; and the Port, IRQ, and Baud set by the GSIOC 
Configuration Editor.
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In the Advanced mode, immediate and buffered GSIOC commands can be sent 
to specific Gilson instruments. In this mode, immediate and buffered commands 
with comments can be saved to a command list to be used as needed. The 
command lines can be repeated automatically to monitor the status of the 
instrument.

Review the Port, IRQ, and Baud information by selecting About... from the Help 
menu. If any information is incorrect or missing, close the GSIOC Utility and use 
the GSIOC Configuration Editor to update the information.

There are four drop-down menus in the Advanced mode of the Gilson GSIOC 
Utility: File Menu, Edit Menu, Mode Menu, and Help Menu.
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Advanced Mode Buttons and Features

+ Button

The  next to  is used to insert an immediate command in the 

command list. For more information, see Insert an Immediate Command on 
page D-14.

The  next to  is used to insert a buffered command in the 

command list. For more information, see Insert a Buffered Command on 
page D-15.

Arrow Up or Arrow Down Button

These buttons (  or ) are used to change the position of a command in 

the command list.

To move a command

Highlight the command in the command list and use  to move the 

command up in the list or  to move the command down in the list.

Immediate Button

Sends an immediate command to the Unit ID selected. The Comment field is not 
used.

Selecting the Immediate button will not add the command to the command list.

For more information, see Send an Immediate Command on page D-16.

Buffered Button

Sends a buffered command to the Unit ID selected. The Comment field is not 
used.

Selecting the Buffered button will not add the command to the command list.

For more information, see Send a Buffered Command on page D-16.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Appendix D

D-8 Gilson 215 Liquid Handler User’s Guide

G
SI

O
C

 U
ti

lit
y Response Field

Returns a response to an immediate or buffered command.

The response will become gray after 15 seconds if no response is registered.

The response to a successfully completed buffered command is “ok”.

Refer to the user’s guide for the Gilson instrument for a description of the valid 
response to the immediate commands.

The response to an unsuccessfully completed immediate or buffered command 
is “#error”.

To send a command line

Double-click on the Unit, Type, Command, Response, or Comment field to send 
the immediate or buffered command for that specific command line.
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Command Line Column Headings

Repeat

A green check mark ( ) in the Repeat column means that an immediate 
command will automatically repeat when the Auto Repeat option is checked. 
Double-click on the Repeat field to select or deselect the Auto Repeat for that 
command line.

A yellow check mark ( ) in the Repeat column means that a buffered command 
will automatically repeat when the Auto Repeat option is checked. Double-click 
on the Repeat field to select or deselect the Auto Repeat option for that 
command line.

Unit

This is the Unit ID for the instrument in the command line.

Type

I - Immediate Command, B - Buffered Command

Command

This is the GSIOC command for the command line.

Response

This is the GSIOC response when the command line is initiated with a 
double-click on the Unit, Type, Command, Response, or Comment field. The 
response will become gray after 15 seconds if no response is registered.

Comment

This is an optional comment that can be added to the command line.
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File Menu

There are four options in the File menu: Open, Save, Save As..., and Exit.

Open

The Open option in the File menu allows you to open previously created 
command lists (GSUTIL32 files). The extension for a GSUTIL32 file is .GSU.

Save

The save option in the File menu allows you to save the Advanced commands to 
GSUTIL32.GSU. The GSUTIL32.GSU file is automatically created in the location 
where GSUTIL32.EXE is stored.

The Advanced commands will automatically be saved to GSUTIL32.GSU if the 
Gilson GSIOC Utility is exited without saving.

The GSUTIL32. GSU is automatically opened when the Advanced mode is 
selected from the Mode menu.

Save As...

The Save As... option on the File menu allows you to save the Gilson GSIOC Utility 
commands that are currently defined. The file’s name and path must be specified.

Exit

Closes the Gilson GSIOC Utility software.

Edit Menu

There are four options in the Edit Menu: Insert Immediate, Insert Buffered, 
Selection, and Font....

Insert Immediate

The Insert Immediate option in the Edit menu allows you to insert an immediate 
command in the command list. The new command will be added to the last line 
in the command list.
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The GSIOC Command will not be inserted if there is already a command line in 
the list with the same Unit ID and Command.

For more information, see Insert an Immediate Command on page D-14.

Insert Buffered

The Insert Buffered option in the Edit menu allows you to insert a buffered 
command in the command list. The new command will be added to the last line 
in the command list.

The GSIOC Command will not be inserted if there is already a command line in 
the list with the same Unit ID and Command.

For more information, see Insert a Buffered Command on page D-15.

Selection

Delete (Ctrl + D)

Deletes the highlighted command from the command list.

Up (Ctrl + U)

Moves the highlighted command up in the command list.

Down (Ctrl + D)

Moves the highlighted command down in the command list.

Execute (Ctrl + E)

Executes the highlighted command.

Repeat (Ctrl + R)

Adds or removes the repeat option for the highlighted command.
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The Font... option on the Edit menu allows you to change the font options for the 
command list fields and headers, as well as the Unit ID, Comment, and Command 
text boxes.

Mode Menu

There are four options in the Mode menu: Scan!, Advanced, Auto Repeat, and 
Ghost.

Scan!

The Scan! option on the Mode menu allows you to 
scan for GSIOC instruments. After a scan, the Unit ID 
list box displays the unit IDs and the version of the 
connected instruments. If any connected 
instruments are missing from the list, ensure that the proper RS-232 or GSIOC 
connection exists between the computer and the instruments, and that the 
instruments do not have duplicate Unit ID numbers.

Advanced

The advanced option in the Mode menu allows you to switch 
between the Basic and Advanced modes. A check mark 
means that the GSIOC Utility is in Advanced mode.

Auto Repeat

The Auto Repeat option on the Mode menu allows you to repeat command lines 
that appear in the command list.

A command line will only repeat if a check mark appears in the Repeat field. A 
check mark can be added by double-clicking on the Repeat field and selecting 
the Auto Repeat check box.

Starting from the top command line, this mode will refresh one repeating 
command line every 1/10th of a second. For example, if there are ten command 
lines with Repeat selected, each of these command lines will be initiated every 
second.

Auto Repeat mode is useful for monitoring the instrument using immediate 
commands and is designated in the Repeat field with a green check mark.
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Auto Repeat mode is not intended to be used as a programming tool with 
buffered commands. Repeating buffered commands will be executed at a fixed 
time interval regardless if a command has finished. For this reason, the check 
mark in the buffered command line is yellow.

Auto Repeat mode can be selected from the Mode menu or by selecting the 
check box next to Auto Repeat.

Auto Repeat is deselected by default with the Advanced mode is first opened. 
When Gilson GSIOC Utility - Advanced is saved or closed, the status of Auto 
Repeat is saved.

Ghost

The Ghost option in the Mode menu makes the GSIOC Utility window 
transparent (and always on top). This allows you to view another window behind 
the Utility. The Utility will remain fully functional in the Ghost mode.

Help Menu

Help Topics

When selected, the Help window for the Gilson GSIOC Utility appears.

About

When selected, the About window appears.

This window displays the version of the Gilson GSIOC Utility, the GSIOC32.DLL, 
and the GSIOC Server or Driver; and the Port, IRQ, and Baud set by the GSIOC 
Configuration Editor.
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Immediate Command

Immediate commands request status information from an instrument. These 
commands are executed immediately, temporarily interrupting any command in 
progress. 

You can find a list of valid immediate commands for each instrument in its 
commands list or user’s guide.

Buffered Command

Buffered commands send instructions to an instrument. These commands are 
executed one at a time. 

You can find a list of valid buffered commands for each instrument in its 
commands list or user’s guide.

Insert an Immediate Command

There are two ways to insert an immediate command in Advanced mode.

Using the Edit Menu

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Select Insert Immediate from the Edit menu. The new command will be 
inserted at the bottom of the command list.

Note: The command will not be inserted if there is already a command line in the 
list with the same Unit ID and command.
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Using the + Button

1 From the Unit ID drop-down box, select the unit ID 
of the instrument to send the command to.

2 Type a Command and Comment. (The comment is 
optional.)

3 Click the  button next to the Immediate 
button. The new command will be inserted at the bottom of the command 
list.

Note: The command will not be inserted if there is already a command line in the 
list with the same Unit ID and command.

Insert a Buffered Command

There are two ways to insert a buffered command in Advanced mode.

Using the Edit Menu

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Select Insert Immediate from the Edit menu. The new command will be 
inserted at the bottom of the command list.

Note: The command will not be inserted if there is already a command line in the 
list with the same Unit ID and command.

Using the + Button

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Click the  button next to the Buffered button. 
The new command will be inserted at the bottom of 
the command list.

Note: The command will not be inserted if there is 
already a command line in the list with the same Unit ID 
and command.
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Basic Mode

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type (or select) a Command.

3 Click .

Advanced Mode

Using the  button

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Click .

Using Execute from the Edit menu

1 Highlight the command to be sent in the command list.

2 Choose Selection from the Edit menu and select Execute. (Or, type Ctrl + E.)

Using the command list

Double-click on the command line of the command you want to send.

Send a Buffered Command

Basic Mode

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type (or select) a Command.

3 Click .
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Advanced Mode

Using the  button

1 From the Unit ID drop-down box, select the unit ID of the instrument to send 
the command to.

2 Type a Command and Comment. (The comment is optional.)

3 Click .

Using Execute from the Edit menu

1 Highlight the command to be sent in the command list.

2 Choose Selection from the Edit menu and select Execute. (Or, type Ctrl + E.)

Using the command list

Double-click on the command line of the command you want to send.
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